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Preface
Thank you for purchasing the DocuPrint CP205/CP205 w.
This guide is intended for users who use the printer for the first time, and provides all the necessary 
operating information about the printer function.
Please read this guide to achieve the best performance from this printer.
This guide assumes you are familiar with computers and the basics of network operation and 
configuration.
After reading this guide, keep it safe and handy for future reference.

DocuPrint CP205/CP205 w User Guide Help

Copyright© 2010 by Fuji Xerox Co., Ltd.

Fuji Xerox Co., Ltd.

October 2010 (Edition 1)

No. ME5047E2-1
5 Preface



Trademarks and Document Disclaimer
Apple®, Bonjour®, ColorSync®, Macintosh®, and Mac OS® are trademarks of Apple Inc. in the United 
States and/or other countries.
Microsoft®, Windows Vista®, Windows®, and Windows Server® are trademarks of 
Microsoft Corporation in the United States and/or other countries.
All product/brand names are trademarks or registered trademarks of the respective holders.

XEROX, the sphere of connectivity design, and DocuPrint are trademarks or registered trademarks of 
Xerox Corporation in the U.S. or Fuji Xerox Co., Ltd. 
DocuWorks is a trademark of Fuji Xerox Co., Ltd. 
All Xerox and Fuji Xerox product names are either registered trademarks or trademarks of Xerox 
Corporation or Fuji Xerox Co., Ltd.

In this manual, safety instructions are preceded by the symbol . Always read and follow the instructions 
before performing the required procedures.

It may be a legal offence to print currency notes, certificates of stocks and securities, or any other documents of 
similar nature, regardless of whether they will be used.

Fuji Xerox is not responsible for any breakdown of machines due to infection of computer virus or computer 
hacking.

IMPORTANT: 
1. This manual is copyrighted with all rights reserved. Under the copyright laws, this manual may not be copied 

or modified in whole or part, without the written consent of the publisher.

2. Parts of this manual are subject to change without prior notice.

3. We welcome any comments on ambiguities, errors, omissions, or missing pages.

4. Never attempt any procedure on the machine that is not specifically described in this manual. Unauthorized 
operation can cause faults or accidents. Fuji Xerox is not liable for any problems resulting from unauthorized 
operation of the equipment.

5. Decompiling this manual is prohibited.

An export of this product is strictly controlled in accordance with Laws concerning Foreign Exchange and 
Foreign Trade of Japan and/or the export control regulations of the United States.
Trademarks and Document Disclaimer 6



Types of Manuals

Safety Guide Describes the information you need to know before using the printer 
and to operate the printer safely.

Setup Guide Provides step-by-step instructions on how to set up your printer.

User Guide (HTML files) 
(this guide)

Describes how to get ready to print and set various features. It also 
covers the operator panel menus, troubleshooting tips, and 
maintenance information.

This guide is on the Software Pack CD-ROM.

Operator Panel Guide Describes the icons assigned to the buttons or indicators on the 
operator panel.
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Using This Guide
This section includes:

• "Organization" on page 9
• "Conventions" on page 10
Using This Guide 8



Organization
This guide is organized into the following chapters. The summary of each chapter is as follows:

1 Specifications Describes the printer specifications.

2 Basic Operation Describes the main components of the printer, the power saver mode, 
and how to turn on the printer.

3 Printer Management Software Describes the software available for the printer.

4 Network Basics Describes the basic information about how to connect the printer to 
your computer via the network or USB and how to install the print 
driver.

5 Printing Basics Describes the supported paper, how to load paper, and how to print 
data using various print features.

6 Using the Operator Panel 
Menus

Describes the setting items available on the operator panel, and their 
setup procedures.

7 Troubleshooting Describes the troubleshooting tips for printer problems such as paper 
jams.

8 Maintenance Describes how to clean the printer, how to replace toner cartridges, 
and how to see the printer status.

9 Contacting Fuji Xerox Describes support information.
9 Using This Guide



Conventions
1 In this guide, personal computers and workstations are collectively called “computers”.

2 The following terms are used throughout this guide:

IMPORTANT: 
• Important information that must be read and followed.

NOTE: 
• Additional information that merits emphasis.

See also: 
• References within this guide.

3 Orientation of documents or paper is described in this guide as follows:
, , Long Edge Feed (LEF): Loading the document or paper in portrait orientation.

, , Short Edge Feed (SEF): Loading the document or paper in landscape orientation.

LEF Orientation SEF Orientation

Paper feed direction Paper feed direction
Using This Guide 10



Safety Notes
Before using this product, read “Safety Notes” carefully for safety use.
This product and recommended supplies have been tested and found to comply with strict safety 
requirements including safety agency approvals and compliance with environmental standards. Follow 
the following instructions for safety use.

Follow all warning instructions marked on this product. The warning marks stand for the followings:

WARNING:
• Any unauthorized alteration including an addition of new functions or connection to external devices 

may not be covered by the product warranty. Contact your local Fuji Xerox representative for more 
information.

Used for item that if not followed strictly, can lead death or severe or 
fatal injuries and the possibility to do it is comparatively high.

Used for items that if not followed strictly, can lead to severe or fatal 
injuries.

Used for items that if not followed strictly, can cause injuries to user or 
damages to machine.

: A symbol for items to pay attention to when handling machine. 

Follow instructions carefully to use machine safely.

: A symbol for prohibited items. Follow instructions carefully to avoid 
any dangerous acts.

: A symbol for items that must be performed. Follow instructions 
carefully to carry out these essential tasks.

Caution Flammable Explodable Electric 
shock

Heated 
surface

Moving 
object

Pinched 
fingers

Prohibited No fire Do not touch Do not use in 
bathroom

Do not tear 
down

Keep away 
from wet

Never touch 
with wet hand

Instructions Unplug Ground/ 
Earth
11 Safety Notes



Electrical Safety

 WARNING
This product shall be operated by the power source as indicated on the product's data plate. Consult 
your local power company to check if your power source meets the requirements.

 CAUTION

WARNING:
• Connect this product to a protective earth circuit.

This product is supplied with a plug that has a protective earth pin. The plug fits only into an 
earthed electrical outlet. This is a safety feature. If the plug doesn't fit to the outlet, contact an 
electrician to replace the outlet to avoid risk of electric shock. Never use an earthed adapter 
plug to connect the product to the electrical outlet that has no earth connection terminal.

Improper connection of a grounding conductor may cause electric shock.

Plug the power cord directly into a grounded electrical outlet. To prevent overheat and a fire 
accident, do not use an extension cord, a multi-plug adaptor or a multiple connector. Consult 
your local Fuji Xerox representative to check if an outlet is grounded.

Connect this product to a branch circuit or an outlet that has larger capacity than the rated 
ampere and voltage of this product. See the data plate on the rear panel of this product for its 
rated ampere and voltage.

Never touch the power cord with wet hands. It may cause electric shock.

Do not place an object on the power cord.

Always keep the plug connection free of dust. The dusty and damp environment may bring 
about minute electric current in a connector. It may generate heat and eventually cause a fire 
accident.

To avoid the risk of electric shock and a fire accident, only use the power cord supplied with this 
product or the ones designated by Fuji Xerox.

The power cord is exclusive use for this product. Do not use it for any other product.

Do not damage or alter the power cord. Damage and alteration may generate heat and 
eventually cause electric shock or a fire accident.

If the power cord is damaged or insulated wires are exposed, contact your local Fuji Xerox 
representative for its replacement. Do not use a damaged or uninsulated cord to avoid the risk 
of electric shock and a fire accident.

When cleaning this product, always switch off and unplug it. Access to a live machine interior 
may cause electric shock.

Do not unplug or re-plug this product with the switch on. Plugging and unplugging a live 
connector may deform the plug and generate heat, and eventually cause a fire accident.

Hold the plug not the cord when unplugging this product, or it may damage the cord and cause 
electric shock or a fire accident.
Safety Notes 12



Always switch off and unplug the machine when it is not used over weekends or long holidays. 
It may cause deterioration of insulations and eventually electric shock or a fire accident.

Once a month, switch off this product and check if
• the power cord is plugged firmly into an electrical outlet;
• the plug is not excessively heated, rusted or bent;
• the plug and electrical outlet are free of dust; and
• the power cord is not cracked or worn down.

Once you notice any unusual condition, switch off and unplug this product first and contact your 
local Fuji Xerox representative.
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Machine Installation

 WARNING

 CAUTION

Do not locate this product where people might step on or trip over the power cord. Friction or 
excessive pressure may generate heat and eventually cause electric shock or a fire accident.

Never locate this product in the following places:
• Near radiators or any other heat sources
• Near volatile flammable materials such as curtains
• In the hot, humid, dusty or poorly ventilated environment
• In the place receiving direct sunlight
• Near cookers or humidifiers

Locate this product on a level and sturdy surface that can withstand a weight of 10.55 Kg. 
Otherwise, if tilted, the product may fall over and cause injuries.

Locate this product in a well-ventilated area. Do not obstruct ventilation openings of the 
product. 

Keep the minimum clearance as follows for ventilation and an access to the power plug. 
Unplug the product if an abnormal condition is noted.

801 mm

443 mm

200 mm

200 mm

100 mm

100 mm

100 mm

100 mm

100 mm

925 mm
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Others

Do not incline the product at more than 10 degree angle. Otherwise, it may fall over and cause 
injuries.

To bundle wires and cables, always use the cable ties and spiral tubes that Fuji Xerox supplies. 
Otherwise, it may cause some defects.

To keep this product in a good performance and condition, always use it in the following 
environment: 
• Temperature: 10 – 32 °C
• Humidity: 10 – 85%

When the product is left in a chilly room and the room is rapidly warmed up by heater, dew 
condensation may form inside the product and cause a partial deletion on printing.

10° 10°

10° 10°

Left

Front

Right

Back

Left

Front

Right

Back
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Operational Safety

 WARNING

 CAUTION

The operator's product maintenance procedures are described in the customer documentation 
supplied with this product. Do not carry out any other maintenance procedures not described in 
the documentation.

This product features safety design not to allow operators access to hazard areas. The hazard 
areas are isolated from operators by covers or protectors which require a tool to remove. To 
prevent electric shock and injuries, never remove those covers and protectors.

To avoid the risk of electric shock and a fire accident, switch off and unplug the product 
promptly in the following conditions, then contact your local Fuji Xerox representative.
• The product emits smoke or its surface is unusually hot.
• The product emits unusual noise or odor.
• The power cord is cracked or worn down.
• A circuit breaker, fuse or any other safety device is activated.
• Any liquid is spilled into the product.
• The product is soaked in water.
• Any part of the product is damaged.

Do not insert any object into slots or openings of this product.
Do not place any of the followings on the product:
• Liquid container such as flower vases or coffee cups
• Metal parts such as staples or clips
• Heavy objects

If liquid is spilled over or metal parts are slipped into the product, it may cause electric shock or 
a fire accident.

Do not use conductive paper such as origami paper, carbonic paper or conductively-coated 
paper. When paper jam occurs, it may cause short-circuit and eventually a fire accident.

When cleaning this product, use the designated cleaning materials exclusive to it. Other 
cleaning materials may result in poor performance of the product. Never use aerosol cleaners, 
or it may catch fire and cause explosion.

Never play the CD-ROM supplied with the product on an audio player. Always use a CD-ROM 
player. Otherwise, large sound may damage audio players or your ears.

Always follow all warning instructions marked on or supplied with this product.

To avoid the risk of burn injuries and electric shock, never touch the area with the “High 
Temperature” or “High Voltage” marks on.

Keep electrical and mechanical safety interlocks active. Keep the safety interlocks away from 
magnetic materials. Magnetic materials may accidentally activate the product and cause 
injuries or electric shock.
Safety Notes 16



Do not attempt to remove a paper jammed deeply inside the product, particularly a paper 
wrapped around a Fusing Unit or a heat roller. Otherwise, it may cause injuries or burns. 
Switch off the product promptly and contact your local Fuji Xerox representative.

Ventilate well during extended operation or mass copying. It may affect the office air 
environment due to odor such as ozone in a poorly ventilated room. 

Provide proper ventilation to ensure the comfortable and safe environment.
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Consumable

 WARNING

 CAUTION

Store all consumables in accordance with the instructions given on its package or container.

Use a broom or a wet cloth to wipe off spilled toner. Never use a vacuum cleaner for the spills. 
It may catch fire by electric sparks inside the vacuum cleaner and cause explosion. If you spill 
a large volume of toner, contact your local Fuji Xerox representative.

Never throw a toner cartridge into an open flame. Remaining toner in the cartridge may catch 
fire and cause burn injuries or explosion.

If you have a used toner cartridge no longer needed, contact your local Fuji Xerox 
representative for its disposal.

Keep toner cartridges out of the reach of children. If a child accidentally swallows toner, spit it 
out, rinse mouth with water, drink water and consult a physician immediately.

When replacing toner cartridges, be careful not to spill the toner. In case of any toner spills, 
avoid contact with clothes, skin, eyes and mouth as well as inhalation.

If toner spills onto your skin or clothing, wash it off with soap and water.

If you get toner particles in your eyes, wash it out with plenty of water for at least 15 minutes 
until irritation is gone. Consult a physician if necessary.

If you inhale toner particles, move to a fresh air location and rinse your mouth with water.

If you swallow toner, spit it out, rinse your mouth with water, drink plenty of water and consult a 
physician immediately.
Safety Notes 18



Warning and Caution Labels
Always follow all warning instructions marked on or supplied with this product.
To avoid the risk of burn injuries and electric shock, never touch the area with the "High Temperature" 
or "High Voltage" marks on.
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Environment
• For environmental protection and efficient use of resources, Fuji Xerox reuses returned toner 

cartridges to make recycle parts, recycle materials or energy recovery.
• Proper disposal is required for toner cartridges no longer needed. Do not open toner cartridges 

containers. Return them to your local Fuji Xerox representative.
Environment 20



Regulation

Radio Frequency Emissions (Class B)

Product Safety Certification (CB)
This product is certified by the following agency using the safety standards listed.

This product has been tested and found to comply with the limits for a Class B digital device, 
pursuant to the International Standard for Electromagnetic Interference (CISPR Publ. 22) and 
Radiocommunications Act 1992 in Australia/New Zealand. These limits are designed to 
provide reasonable protection against harmful interference in a residential installation. This 
product generates, uses and can radiate radio frequency energy and, if not installed and used 
in accordance with the instructions, may cause harmful interference to radio communications. 
However, there is no guarantee that interference will not occur in a particular installation. If this 
product does cause harmful interference to radio or television reception, which can be 
determined by turning this product off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between this product and the receiver.
• Connect this product into an outlet on a circuit different from that to which the receiver is 

connected.
• Consult the dealer or an experienced radio/TV technician for help.

Changes and modifications to this product not specifically approved by Fuji Xerox may void the 
user’s authority to operate this product.

Agency Standard

TUV-Rh IEC60950-1:ed. 2
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Illegal Copies and Printouts
Copying or printing certain documents may be illegal in your country. Penalties of fines or 
imprisonment may be imposed on those found guilty. The following are examples of items that may be 
illegal to copy or print in your country. 

• Currency
• Banknotes and checks
• Bank and government bonds and securities
• Passports and identification cards
• Copyright material or trademarks without the consent of the owner
• Postage stamps and other negotiable instruments

This list is not inclusive and no liability is assumed for either its completeness or accuracy. In case of 
doubt, contact your legal counsel.
Illegal Copies and Printouts 22



Product Features
This chapter describes the product features and indicates their links.

2 Sided Print (Manual)

2 Sided Print is to print two or more pages on 
the front and back sides of a single sheet of 
paper manually. This feature allows you to 
reduce the paper consumption.

For more information, see "Manual Duplex 
Printing (Windows Print Driver Only)" on 
page 140.

Multiple-Up Print

Multiple-Up enables you to print multiple pages 
on a single sheet of paper. This feature allows 
you to reduce the paper consumption.

For more information, see the print driver's 
Help.

Printing Through Wireless Connection 
(Wireless Print) (DocuPrint CP205 w Only)

The Wireless LAN feature on your printer allows 
you to install the printer at any location, and 
enables printing without a wired connection to 
your computer.

The Wireless LAN feature is unavailable 
depending on the region you purchased.

For more information, see "Configuring Wireless 
Settings (DocuPrint CP205 w Only)" on 
page 70.

Priority Sheet Inserter (PSI)

Print media loaded on the PSI is given 
precedence over those loaded on the 
multipurpose feeder (MPF). Using the PSI 
allows you to use other types or sizes of print 
media preferentially over the regular print media 
loaded on the MPF.

For more information, see "Loading Print Media 
in the Priority Sheet Inserter (PSI)" on 
page 134.
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1
Specifications

This chapter lists the main specifications of the printer. Note that the specifications of the product may 
change without prior notice.

Items Description
Product Code DocuPrint CP205 220V: TL300597

DocuPrint CP205 220V CHINA: TL300596

DocuPrint CP205 110V: TL300598

DocuPrint CP205 w 220V: TL300599

Type Desktop

Printing method LED Xerography

IMPORTANT: 
• LED + LED electrophotographic system

Fusing system Thermal fusing system using a belt

Warm-up Time Less than 25 seconds (after powering on at 22 °C temperature) 

Continuous print speed*1 A4 : When plain paper fed is from the multipurpose feeder

Color 1 Sided*2: 12 sheets/min

Monochrome 1 Sided: 15 sheets/min

IMPORTANT: 
*1 Print speed may decrease due to factors such as paper type, paper size, 

and printing conditions.
*2 When continuously printing a single document of A4 .

First print Color 27 seconds (A4 /Fed from the multipurpose feeder)

Monochrome 22 seconds (A4 /Fed from the multipurpose feeder)

IMPORTANT: 
• Measurements based on Fuji Xerox test pattern. Time from printer 

startup until output of the first page is complete. Except the time 
when the printer controller receives or processes the print data.

Resolution Data Processing Resolution:
600 × 600 dpi

Output Resolution:
1200 × 2400 dpi

Tone/Color 256 tones/color (16.7 million colors)
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Paper Size Multipurpose feeder:

A4, B5, A5, Legal (8.5 × 14"), Folio (8.5 × 13"), Letter (8.5 × 11"), 
Executive, #10 Env, Monarch, DL, C5, Postcard (100 × 148 mm), 
Postcard (148 × 200 mm), Yougata 2, Yougata 3, Yougata 4, Younaga 
3, Nagagata 3, Custom Size (Width: 76.2 – 215.9 mm, Length: 127 – 
355.6 mm)

Priority sheet inserter:

A4, B5, A5, Legal (8.5 × 14"), Folio (8.5 × 13"), Letter (8.5 × 11"), 
Executive, #10 Env, Monarch, DL, C5, Postcard (148 × 200 mm), 
Yougata 4, Younaga 3, Nagagata 3, Custom Size (Width: 98.4 – 
215.9 mm, Length: 190.5 – 355.6 mm)

Image loss: 4.1 mm from the top, bottom, left, and right edges

Paper Type Plain, Bond, Lightweight Cardstock, Japanese Glossy Cardstock, 
Lightweight Glossy Cardstock, Recycled, Labels, Envelope, 
Postcard, Letterhead, Pre-Printed, Hole Punched, Colored, Special, 
Custom Type

IMPORTANT: 
• Fuji Xerox P paper (64 gsm)
• Use only the recommended paper. Using paper other than that 

recommended for the printer can cause printing problems. Do not 
use special ink jet paper. 

• Note that poor printing quality due to paper-related printing 
problems can occur when using the printer in an environment that 
is dry, cold, or very humid. 

• Printing over the printed side or on the reverse side of paper that 
already has been printed on can result in poor print quality.

• When printing on envelopes, use envelopes that do not have 
adhesive applied.

• The type of paper being used and environmental conditions can 
affect printing quality. Because of this, it is recommended that you 
test print and confirm proper print quality before using the printer.

Paper capacity Standard:
Multipurpose feeder: 150 sheets; Priority sheet inserter: 10 sheets

IMPORTANT: 
• Fuji Xerox P paper (64 gsm)

Output tray capacity Standard: approximately 100 sheets (face down)

IMPORTANT: 
• Fuji Xerox P paper (64 gsm)

2-sided Printing Feature Standard (Manual)

CPU ARM9 384MHz 

Memory capacity Standard: 128 MB (Onboard)

IMPORTANT: 
• The above memory capacity does not guarantee print quality 

depending on the type and content of print data. 

Hard disk —

Page Description Language — (Host-based)

Items Description
Specifications 26



Supported OS*1 Windows® XP, Windows® XP x64 Edition, Windows Vista®, Windows 
Vista® x64 Edition, Windows Server® 2003, Windows Server® 2003 
x64 Edition, Windows Server® 2008, Windows Server® 2008 x64 
Edition, Windows Server® 2008 R2 x64 Edition, Windows® 7, 
Windows® 7 x64 Edition, Mac OS®*2

IMPORTANT: 
*1 For the latest information about the supported operating systems, contact 

our Customer Support Center or your dealer.
*2 Mac OS® X 10.3.9 – 10.6 are supported.

Interface DocuPrint CP205:

Standard: USB 1.1/2.0 (Hi-Speed), Ethernet (10Base-T, 100Base-TX)

DocuPrint CP205 w:

Standard: USB 1.1/2.0 (Hi-Speed), Ethernet (10Base-T, 100Base-
TX), IEEE802.11b/g/n

Supported protocol TCP/IP (LPR, Port9100, WSD, HTTP, SMTP, RARP, AutoIP), SNMP, 
DHCP, BOOTP, Bonjour (mDNS)

Power AC 100 – 127 V ± 10%; 10.5 A; both 50/60 Hz ± 3 Hz

AC 220 – 240 V ± 10%; 4.5 A; both 50/60 Hz ± 3 Hz

IMPORTANT: 
• Power outlets that provide the above power level is 

recommended. Maximum machine measured current: 
7.0 A (AC 100 – 127 V)/4.0 A (AC 220 – 240 V)

Operating noise

(main unit only)

During operation: 
Color: 6.35 B; 48 dB (A)
Monochrome: 6.35 B; 49 dB (A)

During stand-by: 4.3 B; 21 dB (A)

IMPORTANT: 
• Measurements based on ISO7779

Unit B: acoustic power level (LwAd)
Unit dB (A): radiated sound pressure (bystander position)

Power consumption Maximum: 340 W, During Mode 2 of Power Saver Mode: 7 W or less

Average: 
During standby: 69 W, 
During continuous color printing: 340 W, 
During continuous monochrome printing: 340 W

IMPORTANT: 
• Mode 1 of Power Saver Mode: 14 W average

(The printer does not use electricity when the power is switched 
off even with the power cord is plugged in.)

Dimensions (main unit only) 394 (W) × 300 (D)*1 × 225 (H) mm

IMPORTANT: 
*1 When the front cover is closed.

Items Description
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Weight Main Unit: 10.55 kg (main unit only, including toner cartridges)

Usage Environment During Use: Temperature: 10 – 32 °C; Humidity: 10 – 85% (except 
malfunctions due to dew condensation)

Non-Use: Temperature: -10 – 40 °C; Humidity: 5 – 85% (except 
malfunctions due to dew condensation)

IMPORTANT: 
• Until the conditions (temperature and humidity) inside the printer 

become acclimated to the installation environment, certain 
qualities of the paper can cause poor printing. 

Items Description
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2
Basic Operation

This chapter includes:
• "Main Components" on page 30
• "Turning On the Printer" on page 34
• "Printing a Panel Settings Page" on page 35
• "Power Saver Mode" on page 38
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Main Components
This section provides an overview of your DocuPrint CP205/CP205 w.
This section includes:

• "Front View" on page 31
• "Rear View" on page 32
• "Operator Panel" on page 33
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Front View

1 Operator Panel 2 Center Output Tray

3 Output Tray Extension 4 Print Head Cleaning Rod

5 Toner Access Cover 6 Power Switch

7 Paper Width Guides 8 Multipurpose feeder (MPF)

9 Front Cover 10 Slide Bar

11 Length Guide 12 Priority Sheet Inserter (PSI)

12 11 10 9 8 7 6 5

1 2 3 4

7
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Rear View

1 Power Connector 2 Rear Cover Handle

3 USB Port 4 Ethernet Port

5 Rear Door 6 Transfer Roller

7 Paper Chute 8 Paper Feed Roller

9 Transfer Belt 10 Levers

9
8
7

10

6

1 2

3
4

5
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Operator Panel
The operator panel has a liquid crystal display (LCD), buttons, and indicators.

1  (Energy Saver) Button/Indicator
• Lights up in the Mode 2 for the Power Saver Mode. Press this button to exit the Power Saver 

Mode.

2   Buttons
• Scrolls through menus or items in the Menu mode. To enter numbers or passwords, press 

these buttons.

3   Buttons
• Selects submenus or setting values in the Menu mode.

4  (Cancel Job) Button
• Cancels the current print job.

5  (Error) Indicator
• Lights up when an error occurs and blinks when an unrecoverable error occurs.

6  (Ready) Indicator
• Lights up when the printer is ready or the printer is in the Mode 1 for the Power Saver Mode 

and blinks when data is being received.

7  (Back) Button
• Switches to the print mode from the top menu of the Menu mode.
• Returns to the upper hierarchy of the menu from the submenu of the Menu mode.

8  Button
• Displays the selected menu or item and determines the selected value in the Menu mode.

9 LCD Panel
• Displays various settings, instructions, and error messages. 

10  (Menu) Button
• Moves to the top menu.

OK

110

6 5

4
3

2

7

8

9
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Turning On the Printer
IMPORTANT: 
• Do not use extension cords or power strips.
• The printer should not be connected to an uninterruptible power supply (UPS) system.

1 Connect the power cord to the power connector on the rear of your printer (see "Rear View" on 
page 32).

2 Connect the other end of the cord to the power source.

3 Turn on the printer.
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Printing a Panel Settings Page
The Panel Settings page shows current settings for the operator panel menus. 
This section includes:

• "The Operator Panel" on page 36
• "The Printer Setting Utility" on page 37
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The Operator Panel
1 Press the  (Menu) button.

2 Select Information Pgs, and then press the  button.

3 Select Panel Settings, and then press the  button.
The Panel Settings page is printed.
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The Printer Setting Utility
The following procedure uses Microsoft® Windows® XP as an example.

1 Click start → All Programs → Fuji Xerox → Fuji Xerox Printer Software for Asia-Pacific → 
FX DocuPrint CP205/FX DocuPrint CP205 w → Printer Setting Utility.

NOTE: 
• The Select Printer window appears in this step, when multiple print drivers are installed on your 

computer. In this case, click the name of the desired printer listed in Printer Name.
The Printer Setting Utility appears.

2 Click the Printer Settings Report tab.

3 Select Information Pages from the list at the left side of the page.
The Information Pages page is displayed.

4 Click the Panel Settings button.
The Panel Settings page is printed.
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Power Saver Mode
The printer has a power saving feature which reduces power consumption during periods of inactivity. 
This feature operates in two modes: the Mode 1 and Mode 2. The power consumption of the printer in 
Mode 2 is lower than in Mode 1. As delivered, the printer switches to the Mode 1 five minutes after the 
last print job is printed. The printer then switches to the Mode 2 after another six minutes of inactivity. 
When the printer is in the Mode 1, the display shows Ready/Standby. In the Mode 2, all lamps on 
the operator panel except for the  (Energy Saver) button go out. The display also goes blank and 
displays nothing.
The factory default settings of five minutes (Mode 1) and six minutes (Mode 2) are changeable within 
the range of 5 to 30 minutes (Mode 1) and 1 to 6 minutes (Mode 2). The printer returns to the ready-to-
print state in about 25 seconds when re-activated.

See also: 
• "Setting the PowerSaver Time Option" on page 182
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Exiting the Power Saver Mode
The printer automatically exits the Power Saver Mode when it receives a print job from a computer. To 
manually exit the Mode 1, press any button on the operator panel. To exit the Mode 2, press the  
(Energy Saver) button. 

NOTE: 
• Opening and closing the rear door will cause the printer to exit the Mode 1.
• When the printer is in the Mode 2, all buttons on the operator panel except for the  (Energy Saver) button 

do not function. To use the buttons on the operator panel, press the  (Energy Saver) button to exit the 
Power Saver Mode.

See also: 
• "Setting the PowerSaver Time Option" on page 182
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3
Printer Management Software

Use the Software Pack CD-ROM that shipped with your printer to install a combination of software 
programs, depending on your operating system.
This chapter includes:

• "Print Driver" on page 42
• "CentreWare Internet Services" on page 43
• "Printer Setting Utility (Windows Only)" on page 45
• "SimpleMonitor (Windows Only)" on page 46
• "Launcher (Windows Only)" on page 47
• "User Setup Disk Creating Tool (Windows Only)" on page 48
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Print Driver
To access all of your printer’s features, install the print driver from the Software Pack CD-ROM.
The Print driver enables your computer and printer to communicate and provides access to your 
printer features.

See also: 
• "Installing Print Driver on Computers Running Windows" on page 64
• "Installing Print Driver on Computers Running Mac OS X" on page 103
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CentreWare Internet Services
This section provides information on CentreWare Internet Services, a hyper text transfer protocol 
(HTTP)-based web page service that is installed with your print driver and is accessed through your 
web browser. 
These pages give you instant access to printer status, and printer configuration options. Anyone on 
your network can access the printer using their web browser software. In administrative mode you can 
change the configuration of the printer, and manage your printer settings without leaving your 
computer.

NOTE: 
• Users who are not given passwords by the administrator can still view the configuration settings and options in 

user mode. They will not be able to save or apply any changes to the current configuration.
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Creating an Administrative Password
1 Launch your web browser.

2 Enter the IP address of the printer in the address bar, and then press the Enter key.

3 Click the Properties tab.

4 In the left navigation panel, scroll down to Security and select Administrator Settings.

5 Select Enabled for Administrator Mode. 

6 In the Administrator Login ID field, enter a name for the administrator.

NOTE: 
• The default ID and password are “11111” and “x-admin” respectively.

7 In the Administrator Password and Re-enter Password fields, enter a password for the 
administrator.

8 In the Maximum Login Attempts field, enter the number of login attempts allowed.

9 Click Apply. Your new password has been set and anyone with the administrator name and 
password can log in and change the printer configuration and settings.
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Printer Setting Utility (Windows Only)
The Printer Setting Utility allows you to view or specify the system settings. You can also diagnose the 
system settings by using the Printer Setting Utility.
The Printer Setting Utility consists of the Printer Settings Report, Printer Maintenance, and 
Diagnosis tabs.
The Printer Setting Utility is installed with your Fuji Xerox print driver.

NOTE: 
• The Password dialog box appears the first time you try to change settings on Printer Setting Utility when 

Panel Lock is set on the printer. In this case, enter the password you specified, and click OK to apply the 
settings.
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SimpleMonitor (Windows Only)
You can check the printer status with SimpleMonitor. Double-click the SimpleMonitor printer icon on 
the taskbar at the bottom right of the screen. The Select Printer window appears, which displays the 
printer name, printer connection ports, and printer status. Check the column Status to know the 
current status of your printer. 
Status Settings button: Displays the Status Settings screen and allows you to modify the 
SimpleMonitor settings.
Click the name of the desired printer listed on the Select Printer window. The Status Monitor window 
appears.
The Status Monitor window alerts you when there is a warning or when an error occurs, for example, 
when a paper jam occurs or toner is running low.
By default, the Status Monitor window launches automatically when printing starts. You can specify 
the conditions for starting the Status Monitor window in Auto start setup.

To change the pop-up settings for the Status Monitor window:
The following procedure uses Microsoft® Windows® XP as an example.

1 Click start → All Programs → Fuji Xerox → SimpleMonitor for Asia-Pacific → Activate 
SimpleMonitor.
The Select Printer window appears.

2 Click Status Settings.
The Status Settings dialog box appears.

3 Select the Pop-up Settings tab, and then select the type of the pop-up from Auto start setup.

You can also check the toner level of your printer and the job information on the Status Monitor 
window.
The SimpleMonitor is installed with your Fuji Xerox print driver.
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Launcher (Windows Only)
Using the Launcher window, you can open the Status Window, Printer Setting Utility, and 
Troubleshooting.
To use the Launcher, select to install the Launcher when you install the Fuji Xerox print driver.
The following procedure uses Windows XP as an example.
To open the Launcher window:

1 Click start → All Programs → Fuji Xerox → Fuji Xerox Printer Software for Asia-Pacific → 
Launcher.
The Launcher dialog box appears.

2 The Launcher window provides three buttons; Status Window, Printer Setting Utility, and 
Troubleshooting.
To exit, click the X button at the top-right of the window.

For details, click the Help button/icon of each application.

Status Window Click to open the Status Monitor window. 

See also: 
• "SimpleMonitor (Windows Only)" on page 46

Printer Setting Utility Click to open the Printer Setting Utility. 

See also: 
• "Printer Setting Utility (Windows Only)" on page 45

Troubleshooting Click to open the Troubleshooting guide, which allows you to resolve 
issues by yourself.
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User Setup Disk Creating Tool (Windows Only)
The User Setup Disk Creating Tool program located in the MakeDisk folder of the Utilities folder on 
the Software Pack CD-ROM and the print driver located on the Software Pack CD-ROM are used to 
create driver installation packages that contain custom driver settings. A driver installation package 
can contain a group of saved print driver settings and other data for things such as:

• Print orientation and Multiple-UP (document settings) 
• Watermarks 

If you want to install the print driver with the same settings on multiple computers running on the same 
operating system, create a setup disk in a floppy disk or in a server on the network. Using the setup 
disk that you have created will reduce the amount of work required when installing the print driver.

• Install the DocuPrint CP205/CP205 w print driver in the computer on which the setup disk is to be 
created.

• The setup disk can only be used on the operating system on which the disk was created or 
computers running the same operating system. Create a separate setup disk for each of the 
operating systems.
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4
Network Basics

This chapter includes:
• "Overview of Network Setup and Configuration" on page 50
• "Connecting Your Printer" on page 51
• "Setting the IP Address" on page 55
• "Installing Print Driver on Computers Running Windows" on page 64
• "Installing Print Driver on Computers Running Mac OS X" on page 103
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Overview of Network Setup and Configuration
To set up and configure the network:

1 Connect the printer to the network using the recommended hardware and cables.

2 Turn on the printer and the computer.

3 Print the Printer Settings page and keep it for referencing network settings. 

4 Install the driver software on the computer from the Software Pack CD-ROM. For information on 
driver installation, see the section in this chapter for the specific operating system you are using.

5 Configure the printer’s TCP/IP address, which is required to identify the printer on the network. 
• Microsoft® Windows® operating systems: Run the Installer on the Software Pack CD-ROM to 

automatically set the printer’s Internet Protocol (IP) address if you connect the printer to an 
established TCP/IP network. You can also manually set the printer’s IP address on the 
operator panel.

• Mac OS® X systems: Manually set the printer’s TCP/IP address on the operator panel.

6 Print a Printer Settings page to verify the new settings.

NOTE: 
• If the Software Pack CD-ROM is not available, you can download the latest driver from the Fuji Xerox Web 

Site: http://www.fujixeroxprinters.com/ 

See also: 
• "Printing a Printer Settings Page" on page 156
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Connecting Your Printer
Your DocuPrint CP205/CP205 w interconnection cables must meet the following requirements:

Connection Type Connection Specifications
Ethernet 10 Base-T/100 Base-TX compatible

USB USB 1.1/2.0 compatible

Wireless (DocuPrint CP205 w 
only)

IEEE 802.11b/802.11g/802.11n

1 USB Port

2 Ethernet Port

1
2
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Connecting Printer to Computer or Network
Connect the printer via Ethernet or USB. A USB connection is a direct connection and is not used for 
networking. An Ethernet connection is used for networking. Hardware and cabling requirements vary 
for the different connection methods. Ethernet cable and hardware are generally not included with 
your printer and must be purchased separately.
The available feature for each connection type is shown in the following table.

Connection Type Available Feature
USB When connected via USB, you can instruct print jobs from a 

computer.

Ethernet When connected via Ethernet, you can instruct print jobs from a 
computer on the network.
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USB Connection
A local printer is a printer which is directly attached to your computer using the USB cable. If your 
printer is attached to a network instead of your computer, skip this section and go to "Network 
Connection" on page 54.
The following operating systems support USB connection:

• Windows XP
• Windows XP 64-bit Edition
• Windows Server® 2003
• Windows Server 2003 x64 Edition
• Windows Server 2008
• Windows Server 2008 64-bit Edition
• Windows Server 2008 R2
• Windows Vista®

• Windows Vista 64-bit Edition
• Windows 7
• Windows 7 64-bit Edition
• Mac OS X 10.3.9/10.4.11/10.5.8 -10.6

To attach the printer to a computer:

1 Ensure that the printer, computer, and any other attached devices are turned off and unplugged 
from the power source/outlet.

2 Connect the smaller USB connector into the USB port at the back of the printer and the other end 
of the cable into a USB port of the computer.

NOTE: 
• Do not connect the printer USB cable to the USB connector available on the keyboard.

USB port
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Network Connection
To connect the printer to a network:

1 Ensure that the printer, computer and any other connected devices have been turned off and all 
cables have been disconnected.

2 Connect one end of an Ethernet cable into the Ethernet port at the rear of the printer, and the 
other end to a LAN drop or hub.

NOTE: 
• Connect the Ethernet cable, only if you need to setup a wired connection.

See also: 
• "Configuring Wireless Settings (DocuPrint CP205 w Only)" on page 70

Ethernet port
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Setting the IP Address
This section includes:

• "TCP/IP and IP Addresses" on page 56
• "Automatically Setting the Printer’s IP Address" on page 57
• "Dynamic Methods of Setting the Printer’s IP Address" on page 58
• "Assigning an IP Address (for IPv4 Mode)" on page 59
• "Verifying the IP Settings" on page 62
• "Printing and Checking the Printer Settings Page" on page 63
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TCP/IP and IP Addresses
If your computer is on a large network, contact your network administrator for the appropriate TCP/IP 
addresses and additional system settings information. 
If you are creating your own small Local Area Network or connecting the printer directly to your 
computer using Ethernet, follow the procedure for automatically setting the printer’s IP address. 
Computers and printers primarily use TCP/IP protocols to communicate over an Ethernet network. 
With TCP/IP protocols, each printer and computer must have a unique IP address. It is important that 
the addresses are similar, but not the same; only the last digit needs to be different. For example, your 
printer can have the address 192.168.1.2 while your computer has the address 192.168.1.3. Another 
device can have the address 192.168.1.4.
Many networks have a Dynamic Host Configuration Protocol (DHCP) server. A DHCP server 
automatically programs an IP address into every computer and printer on the network that is 
configured to use DHCP. A DHCP server is built into most cable and Digital Subscriber Line (DSL) 
routers. If you use a cable or DSL router, see your router’s documentation for information on IP 
addressing.
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Automatically Setting the Printer’s IP Address
If the printer is connected to a small established TCP/IP network without a DHCP server, use the 
installer on the Software Pack CD-ROM to detect or assign an IP address to your printer. For further 
instructions, insert the Software Pack CD-ROM into your computer’s CD-ROM drive. After the Installer 
launches, follow the prompts for installation. 

NOTE: 
• For the automatic installer to function, the printer must be connected to an established TCP/IP network.
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Dynamic Methods of Setting the Printer’s IP Address
There are two protocols available for dynamically setting the printer’s IP address: 

• DHCP (enabled by default)
• AutoIP

You can turn on/off both protocols using the operator panel, or use CentreWare Internet Services to 
turn on/off DHCP.

NOTE: 
• You can print a report that includes the printer’s IP address. On the operator panel, press the  (Menu) 

button, select Information Pgs, press the  button, select Printer Settings, and then press the  
button. The IP address is listed on the Printer Settings page.

Using the Operator Panel
To turn on/off either the DHCP or AutoIP protocol:

1 On the operator panel, press the  (Menu) button.

2 Select Admin Menu, and then press the  button.

3 Select Network Setup, and then press the  button.

4 Select TCP/IP, and then press the  button.

5 Select IPv4, and then press the  button.

6 Select Get IP Address, and then press the  button.

7 Select DHCP/AutoIP, and then press the  button.

Using CentreWare Internet Services
To turn on/off the DHCP protocol:

1 Launch your web browser.

2 Enter the IP address of the printer in the address bar, and then press the Enter key.

3 Select Properties.

4 Select TCP/IP from the Protocol Settings folder on the left navigation panel.

5 In the Get IP Address field, select the DHCP / Autonet option.

6 Click the Apply button.
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Assigning an IP Address (for IPv4 Mode)
NOTE: 
• When you assign an IP address manually in IPv6 mode, use the CentreWare Internet Services. To display the 

CentreWare Internet Services, use the link local address. To check a link local address, see "Printing and 
Checking the Printer Settings Page" on page 63.

• Assigning an IP address is considered as an advanced function and is normally done by a system 
administrator.

• Depending on the address class, the range of the IP address assigned may be different. On Class A, for 
example, an IP address in the range from 0.0.0.0 to 127.255.255.255 will be assigned. For assignment 
of IP addresses, contact your system administrator. 

You can assign the IP address by using the operator panel or using the Printer Setting Utility.
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The Operator Panel

1 Turn on the printer.
Ensure that Ready message appears on the LCD panel.

2 On the operator panel, press the  (Menu) button.

3 Select Admin Menu, and then press the  button.

4 Select Network Setup, and then press the  button.

5 Select TCP/IP, and then press the  button.

6 Select IPv4, and then press the  button.

7 Select Get IP Address, and then press the  button.

8 Ensure that Panel is selected, and then press the  (Back) button.

9 Ensure that Get IP Address is selected.

10 Select IP Address, and then press the  button.
The cursor is located at the first digit of the IP address.

11 Enter the value of the IP address using the  or  button.

12 Press the  button.
The next digit is selected.

13 Repeat steps 11 to 12 to enter all of the digits in the IP address, and then press the  button.

14 Press the  (Back) button, and then ensure that IP Address is selected.

15 Select Network Mask, and then press the  button.
The cursor is located at the first digit of the network mask.

16 Enter the value of the network mask using the  or  button.

17 Press the  button.
The next digit is selected.

18 Repeat steps 16 to 17 to set network mask, and then press the  button.

19 Press the  (Back) button, and then ensure that Network Mask is selected.

20 Select Gateway Address, and then press the  button.
The cursor is located at the first digit of the gateway address.

21 Enter the value of the gateway address using the  or  button.

22 Press the  button.
The next digit is selected.

23 Repeat steps 21 to 22 to set gateway address, and then press the  button.
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24 Turn off and turn on the printer.

See also: 
• "Operator Panel" on page 33

The Printer Setting Utility
The following procedure uses Windows XP as an example.

NOTE: 
• When you use IPv6 mode for network printing, you cannot use the Printer Setting Utility to assign an IP 

address.

1 Click start → All Programs → Fuji Xerox → Fuji Xerox Printer Software for Asia-Pacific → 
FX DocuPrint CP205/FX DocuPrint CP205 w → Printer Setting Utility.

NOTE: 
• The Select Printer window appears in this step, when multiple print drivers are installed on your 

computer. In this case, click the name of the desired printer listed in Printer Name.
The Printer Setting Utility appears.

2 Click the Printer Maintenance tab.

3 Select TCP/IP Settings from the list at the left side of the page.
The TCP/IP Settings page is displayed.

4 Select the mode from IP Address Mode, and then enter the values in IP Address, Network 
Mask, and Gateway Address.

5 Click the Restart printer to apply new settings button to take effect.
The IP address is assigned to your printer. To verify the setting, display the web browser on any 
computer connected to the network and enter the IP address into the address bar on the browser. If 
the IP address is set up correctly, the CentreWare Internet Services displays in your browser.
You can also assign the IP address to the printer when installing the print drivers with installer. When 
you use the network installation feature, and the Get IP Address is set to DHCP/AutoIP on the 
operator panel menu, you can set the IP address from 0.0.0.0 to the desired IP address on the 
printer selection window. 
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Verifying the IP Settings
The following procedure uses Windows XP as an example.

1 Print the Printer Settings page.

2 Look under the IPv4 heading on the Printer Settings page to ensure that the IP address, network 
mask, and gateway address are appropriate.

To verify if the printer is active on the network, run the ping command in your computer:

1 Click start, and select Run.

2 Enter cmd, and then click OK.
A black window is displayed.

3 Enter ping xx.xx.xx.xx (where xx.xx.xx.xx is the IP address of your printer), and then press the 
Enter key.

4 Reply from the IP address denotes printer is active on the network.

See also: 
• "Printing and Checking the Printer Settings Page" on page 63
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Printing and Checking the Printer Settings Page
Print the Printer Settings page and check your printer's IP address.
This section includes:

• "The Operator Panel" on page 63
• "The Printer Setting Utility" on page 63

The Operator Panel

1 Press the  (Menu) button.

2 Select Information Pgs, and then press the  button.

3 Select Printer Settings, and then press the  button.
The Printer Settings page is printed.

4 Confirm the IP address next to IP Address under Network Setup on the Printer Settings page. If 
the IP address is 0.0.0.0, wait for a few minutes to resolve the IP address automatically, and then 
print the Printer Settings page again.
If the IP address is not resolved automatically, see "Assigning an IP Address (for IPv4 Mode)" on 
page 59.

The Printer Setting Utility
The following procedure uses Windows XP as an example.

1 Click start → All Programs → Fuji Xerox → Fuji Xerox Printer Software for Asia-Pacific → 
FX DocuPrint CP205/FX DocuPrint CP205 w → Printer Setting Utility.

NOTE: 
• The Select Printer window appears in this step, when multiple print drivers are installed on your 

computer. In this case, click the name of the desired printer listed in Printer Name.
The Printer Setting Utility appears.

2 Click the Printer Settings Report tab.

3 Select Information Pages from the list at the left side of the page.
The Information Pages page is displayed.

4 Click the Printer Settings button.
The Printer Settings page is printed.

If the IP address is 0.0.0.0 (the factory default) or 169.254.xx.xx, an IP address has not been 
assigned. 

See also: 
• "Assigning an IP Address (for IPv4 Mode)" on page 59
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Installing Print Driver on Computers Running 
Windows
This section includes:

• "Identifying Print Driver Pre-install Status (for Network Connection Setup)" on page 65
• "Inserting the Software Pack CD-ROM" on page 67
• "USB Connection Setup" on page 68
• "Network Connection Setup" on page 69
• "Configuring Wireless Settings (DocuPrint CP205 w Only)" on page 70
• "Setting Up for Shared Printing" on page 95
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Identifying Print Driver Pre-install Status (for Network 
Connection Setup)

Before installing the print driver on your computer, print the Printer Settings page to check the IP 
address of your printer.
The following procedure uses Windows XP as an example.
This section includes:

• "The Operator Panel" on page 65
• "The Printer Setting Utility" on page 65
• "Disabling the Firewall Before Installing Your Printer" on page 66

The Operator Panel

1 Press the  (Menu) button.

2 Select Information Pgs, and then press the  button.

3 Select Printer Settings, and then press the  button.
The Printer Settings page is printed.

4 Find the IP address under Network Setup/Wireless Setup on the Printer Settings page.
If the IP address is 0.0.0.0, wait for a few minutes to resolve the IP address automatically, and 
then print the Printer Settings page again.

If the IP address is not resolved automatically, see "Assigning an IP Address (for IPv4 Mode)" on 
page 59.

The Printer Setting Utility

1 Click start → All Programs → Fuji Xerox → Fuji Xerox Printer Software for Asia-Pacific → 
FX DocuPrint CP205/FX DocuPrint CP205 w → Printer Setting Utility.

NOTE: 
• The Select Printer window appears in this step, when multiple print drivers are installed on your 

computer. In this case, click the name of the desired printer listed in Printer Name.
The Printer Setting Utility appears.

2 Select TCP/IP Settings from the list on the left side of the page.
The TCP/IP Settings page appears.

If the IP address shows 0.0.0.0 (the factory default) or 169.254.xx.xx, an IP address has not been 
assigned. To assign one for your printer, see "Assigning an IP Address (for IPv4 Mode)" on page 59.
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Disabling the Firewall Before Installing Your Printer
NOTE: 
• For Windows XP, Service Pack 2 or 3 must be installed.

If you are running one of the following operating systems, you must disable the firewall before 
installing the Fuji Xerox printer software:

• Windows 7
• Windows Vista
• Windows Server 2008 R2
• Windows Server 2008
• Windows XP

The following procedure uses Windows XP as an example.

1 Click start → Help and Support.

NOTE: 
• For Windows Vista, Windows Server 2008, Windows Server 2008 R2 and Windows 7 operating systems, 

if you use Online Help, switch to Offline Help on Windows Help and Support window.

2 In the Search box, enter firewall and then press the Enter key.
In the list, click Turn Windows Firewall on or off and then follow the instructions on the screen.

Enable the firewall after the installation of the Fuji Xerox printer software is complete.
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Inserting the Software Pack CD-ROM
1 Insert the Software Pack CD-ROM into your computer to start Easy Install Navi.

NOTE: 
• If the CD does not automatically launch, click Start (start for Windows XP) → All Programs (for 

Windows Vista and Windows 7) → Accessories (for Windows Vista and Windows 7) → Run, and then 
enter D:\setup.exe (where D is the drive letter of your CD), and then click OK.
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USB Connection Setup
The following procedure uses Windows XP as an example.

• When the Printer is Connected to Computer With a USB Cable

1 Turn on the printer.

NOTE: 
• If Found New Hardware Wizard appears, click Cancel at this time.

2 Click Installing Drivers and Software.

3 Select Personal Installation (USB), and then click Next.

4 If you agree to the terms of the License Agreement, click I accept the terms of the license 
agreement to continue the installation process, and then click Next.

5 Follow the on-screen instructions.
The Plug and Play installation starts and the installation software proceeds to the next page 
automatically.

6 Click Finish to exit the wizard when the "Congratulations!" screen appears. If necessary, click 
Print Test Page to print a test page.

• When the Printer is not Connected to Computer With a USB Cable

1 Turn off the printer.

2 Click Installing Drivers and Software.

3 Select Personal Installation (USB), and then click Next.

4 If you agree to the terms of the License Agreement, click I accept the terms of the license 
agreement to continue the installation process, and then click Next.

5 Follow the on-screen instructions to connect the computer and the printer with the USB cable, 
and then turn on the printer.

6 Click Finish to exit the wizard.

7 Proceed the Plug and Play installation.

• USB Printing
A personal printer is a printer attached to your computer or a print server using a USB. If your printer is 
attached to a network and not your computer, see "Network Connection Setup" on page 69.
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Network Connection Setup
1 Click Installing Drivers and Software.

2 Select Network Installation, and then click Next.

3 If you agree to the terms of the License Agreement, click I accept the terms of the license 
agreement to continue the installation process, and then click Next.

4 Select the printer you want to install from the printer list, and then click Next. If the target printer 
is not displayed on the list, click Refresh to refresh the list or click Manually add using IP 
address to add a printer to the list manually. You may specify the IP address and port name at 
this point.
If you have installed this printer on the server computer, select I am setting up this printer on a 
server check box.

NOTE: 
• When using AutoIP, 0.0.0.0 is displayed in the installer. Before you can continue, you must enter a valid 

IP address.

5 Specify the printer settings, and then click Next.
a Enter the printer name.
b If you want other users on the network to access this printer, select Share this printer with 

other computers on the network, and then enter a share name that users can identify.
c If you want to set a printer as the default, select the Set this printer as default check box.

6 Select the software and documentation you want to install, and then click Install. You can specify 
folders in which to install the software and documentation. To change the folders, click Browse.

7 Click Finish to exit the wizard when the "Congratulations!" screen appears. If necessary, click 
Print Test Page to print a test page.
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Configuring Wireless Settings (DocuPrint CP205 w Only)
This section describes how to configure wireless settings through Easy Install Navi.

IMPORTANT: 
• The Wireless LAN feature is unavailable depending on the region you purchased.

The specifications of wireless setting function are described below:

You can select a method to configure a wireless setting from the following:

NOTE: 
• For information on how to install a wireless, see "Using Wizard Setup to Configure Wireless Settings" on 

page 71 or "Using Advanced Setup to Configure Wireless Settings" on page 73.

Item Specification
Connectivity Wireless

Connectivity Standard IEEE 802.11b/g/n compliant

Bandwidth 2.4 GHz

Data Transfer Rate IEEE 802.11b mode: 11, 5.5, 2, 1 Mbps 

IEEE 802.11g mode: 54, 48, 36, 24, 18, 12, 9, 6 Mbps 

IEEE 802.11n mode: 65 Mbps

Security 64 (40-bit key)/ 128 (104- bit key) WEP, WPA- PSK (TKIP, AES), 
WPA2-PSK (AES)(IEEE802.1x attestation function of WPA 1x non-
corresponds)

Certifications Wi-Fi, WPA2.0 (Personal)

Wi-Fi Protected Setup (WPS) Push Button Configuration (PBC), Personal Identification Number 
(PIN)

Wizard Setup Through USB Connection
Advanced Setup Through Ethernet connection

Operator Panel

CentreWare Internet Services

WPS-PIN*1

WPS-PBC*2

*1 WPS-PIN (Wi-Fi® Protected Setup-Personal Identification Number) is a method to authenticate and 
register devices required for wireless configuration, by entering PIN assignments in the printer and 
computer. This setting, performed through access point, is available only when the access points of your 
wireless router supports WPS.

*2 WPS-PBC (Wi-Fi Protected Setup-Push Button Configuration) is a method to authenticate and register 
devices required for wireless configuration, by pressing the button provided on the access point via 
wireless routers, and then performing WPS-PBC setting on the operator panel. This setting is available 
only when the access point supports WPS.
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Using Wizard Setup to Configure Wireless Settings
The following procedure uses Windows XP as an example.

1 Insert the Software Pack CD-ROM provided with the printer in your computer. The Easy Install 
Navi launches automatically. 

2 Click Start Setup.

3 Click Connect Your Printer.
Select your type of connection screen appears.

4 Select Wireless Connection, and then click Next.
The setting method selection window appears.

5 Ensure that Wizard is selected, and then click Next.
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6 Follow the instructions until the Check Setup screen appears.

7 Confirm there are no errors displayed on the LCD panel, and then click Start Installation.
If you see any errors, click Trouble Shooting Guide and follow the instruction.

8 If you agree to the terms of the License Agreement, click I accept the terms of the license 
agreement to continue the installation process, and then click Next.

9 Check if the printer to be installed is listed in the Select Printer screen, and then click Next.

NOTE: 
• If the printer to be installed is not listed in the Select Printer screen, try the following steps:

- Click Refresh to update the information.
- Click Manually add using IP address, and then enter the details of the printer manually.

10 Select the required items on the Enter Printer Settings screen, and then click Next.

11 Select the software to be installed, and then click Install.
The "Congratulations!" screen appears.

12 Click Finish to exit this tool.
The wireless configuration is complete.
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Using Advanced Setup to Configure Wireless Settings
To use the Advanced setup, display the Configure Wireless Settings screen.
The following procedure uses Windows XP as an example.
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• Displaying Configure Wireless Settings Screen

1 Insert the Software Pack CD-ROM provided with the printer in your computer. The Easy Install 
Navi launches automatically.

2 Click Start Setup.

3 Click Connect Your Printer.

4 Select Wireless Connection, and then click Next.
The setting method selection window appears.

5 Select Advanced.
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• Select a connection method from the following
• "Ethernet Cable" on page 76
• "WPS-PIN" on page 79
• "WPS-PBC" on page 81
• "Operator Panel" on page 83
• "CentreWare Internet Services" on page 84
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• Ethernet Cable

1 Select Ethernet Cable, and then click Next.

2 Follow the instructions, and then click Next.
The Printer Setup Utility screen appears.

3 Select the printer to be configured in the Select Printer screen, and then click Next.

NOTE: 
• If the printer to be configured is not listed in the Select Printer screen, try the following steps:

- Click Refresh to update the information.
- Click Enter IP Address, and then enter the IP address of your printer.

4 Enter the SSID.

5 Select Type of wireless network.

6 Configure the security setting, and then click Next.
The IP Address Settings screen appears.

7 Select IP Mode depending on your network scheme.
When IPv4 is selected:

• Configure the following:
a Select Type.
b Enter the following items:

• IP Address of your printer
• Network Mask
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• Gateway Address
When IPv6 is selected:

• Configure the following:
a Select Use Manual Address.
b Enter IP address of your printer.
c Enter the gateway address of your network.
When Dual Stack is selected:

Configure the IPv4 Settings and IPv6 Settings.

8 Click Next.

9 Ensure that the wireless settings are displayed, and then click Apply.
The Complete configuration screen appears.

10 Click Next.

11 Follow the instructions until the Check Setup screen appears.

12 Confirm there are no errors displayed on the LCD panel, and then click Start Installation.
If you see any errors, click Trouble Shooting Guide and follow the instruction.

13 If you agree to the terms of the License Agreement, click I accept the terms of the license 
agreement to continue the installation process, and then click Next.

14 Check if the printer to be installed is listed in the Select Printer screen, and then click Next.
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NOTE: 
• If the printer to be installed is not listed in the Select Printer screen, try the following steps:

- Click Refresh to update the information.
- Click Manually add using IP address, and then enter the details of the printer manually.

15 Configure the required items on the Enter Printer Settings screen, and then click Next.

16 Select the software to be installed, and then click Install.
The "Congratulations!" screen appears.

17 Click Finish to exit this tool.
The wireless configuration is complete.
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• WPS-PIN
NOTE: 
• WPS-PIN (Wi-Fi Protected Setup-Personal Identification Number) is a method to authenticate and register 

devices required for wireless configuration, by entering PIN assignments to a printer and computer. This 
setting, performed through access point, is available only when the access points of your wireless router 
supports WPS.

1 Select WPS-PIN, and then click Next.

2 Follow the instructions until the Check Setup screen appears.

3 Confirm there are no errors displayed on the LCD panel, and then click Start Installation.
If you see any errors, click Trouble Shooting Guide and follow the instruction.

4 If you agree to the terms of the License Agreement, click I accept the terms of the license 
agreement to continue the installation process, and then click Next.

5 Check if the printer to be installed is listed in the Select Printer screen, and then click Next.

NOTE: 
• If the printer to be installed is not listed in the Select Printer screen, try the following steps:

- Click Refresh to update the information.
- Click Manually add using IP address, and then enter the details of the printer manually.

6 Configure the required items on the Enter Printer Settings screen, and then click Next.

7 Select the software to be installed, and then click Install.
79 Network Basics



The "Congratulations!" screen appears.

8 Click Finish to exit this tool.
The wireless configuration is complete.

When the WPS-PIN operation is successful and the printer is rebooted, wireless LAN connection is 
completed.
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• WPS-PBC
NOTE: 
• WPS-PBC (Wi-Fi Protected Setup-Push Button Configuration) is a method to authenticate and register 

devices required for wireless configuration, by pressing the button provided on the access point via wireless 
routers, and then performing WPS-PBC setting on the operator panel. This setting is available only when the 
access point supports WPS.

1 Select WPS-PBC, and then click Next.

2 Follow the instructions until the Check Setup screen appears.

3 Confirm there are no errors displayed on the LCD panel, and then click Start Installation.
If you see any errors, click Trouble Shooting Guide and follow the instruction.

4 If you agree to the terms of the License Agreement, click I accept the terms of the license 
agreement to continue the installation process, and then click Next.

5 Check if the printer to be installed is listed in the Select Printer screen, and then click Next.

NOTE: 
• If the printer to be installed is not listed in the Select Printer screen, try the following steps:

- Click Refresh to update the information.
- Click Manually add using IP address, and then enter the details of the printer manually.

6 Configure the required items on the Enter Printer Settings screen, and then click Next.

7 Select the software to be installed, and then click Install.
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The "Congratulations!" screen appears.

8 Click Finish to exit this tool.
The wireless configuration is complete.

NOTE: 
• For WPS-PBC operation on the wireless LAN access point, refer to the manual supplied with the wireless 

LAN access point.

When the WPS-PBC operation is successful and the printer is rebooted, wireless LAN connection is 
completed.
Network Basics 82



• Operator Panel

1 Select Operator Panel, and then click Next.

2 Follow the instructions until the Check Setup screen appears.

3 Confirm there are no errors displayed on the LCD panel, and then click Start Installation.
If you see any errors, click Trouble Shooting Guide and follow the instruction.

4 If you agree to the terms of the License Agreement, click I accept the terms of the license 
agreement to continue the installation process, and then click Next.

5 Check if the printer to be installed is listed in the Select Printer screen, and then click Next.

NOTE: 
• If the printer to be installed is not listed in the Select Printer screen, try the following steps:

- Click Refresh to update the information.
- Click Manually add using IP address, and then enter the details of the printer manually.

6 Configure the required items on the Enter Printer Settings screen, and then click Next.

7 Select the software to be installed, and then click Install.
The "Congratulations!" screen appears.

8 Click Finish to exit this tool.
The wireless configuration is complete.
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• CentreWare Internet Services

1 Select CentreWare Internet Services, and then click Next.

2 Follow the instructions until the Check Setup screen appears.

3 Confirm there are no errors displayed on the LCD panel, and then click Start Installation.
If you see any errors, click Trouble Shooting Guide and follow the instruction.

4 If you agree to the terms of the License Agreement, click I accept the terms of the license 
agreement to continue the installation process, and then click Next.

5 Check if the printer to be installed is listed in the Select Printer screen, and then click Next.

NOTE: 
• If the printer to be installed is not listed in the Select Printer screen, try the following steps:

- Click Refresh to update the information.
- Click Manually add using IP address, and then enter the details of the printer manually.

6 Configure the required items on the Enter Printer Settings screen, and then click Next.

7 Select the software to be installed, and then click Install.
The "Congratulations!" screen appears.

8 Click Finish to exit this tool.
The wireless configuration is complete.
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When the CentreWare Internet Services operation is successful and the printer is rebooted, wireless 
LAN connection is completed.
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Setting up a New Wireless Network Environment for Your Computer 
(When You Need to Setup Your Wireless Connectivity With Your 
Computer)

• For DHCP Network:

1 Setting up your computer for wireless connectivity:

NOTE: 
• You can also change the wireless settings using the wireless application that may be installed in your 

computer.
For Windows XP and Windows Server 2003:

a Select Network Connections from Control Panel.
b Right-click Wireless Network Connection and select Properties.
c Select the Wireless Networks tab.
d Ensure that the check box for Use Windows to configure my wireless network settings is 

selected.

NOTE: 
• Make note of the wireless settings on the Advanced window (step f) and the Wireless network 

properties window (step h). You may require these settings later.

e Click the Advanced button.
f Select Computer-to-computer (ad hoc) networks only and close the Advanced dialog 

box.
g Click the Add button to display Wireless network properties.
h On the Association tab, enter the following information and click OK.

Network name (SSID): xxxxxxxx (xxxxxxxx indicates a wireless device’s SSID which you 
use)

Network Authentication: Open

Data encryption: Disabled
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i Click the Move up button to move the newly added SSID to the top of the list.
j Click OK to close the Wireless Network Connection Properties dialog box. 
For Windows Vista:

a Display Control Panel.
b Select Network and Internet.
c Select Network and Sharing Center.
d Select Connect to a network.
e Select xxxxxxxx (xxxxxxxx indicates a wireless device’s SSID which you use) from the 

network items listed in the available network list, and click Connect.
f Click Close in the dialog box after confirming the connection is a success.
For Windows Server 2008:

a Display Control Panel.
b Select Network and Internet.
c Select Network and Sharing Center.
d Select Connect to a network.
e Select xxxxxxxx (xxxxxxxx indicates a wireless device’s SSID which you use) from the 

network items listed in the available network list, and click Connect.
f Click Close in the dialog box after confirming the connection is a success.
For Windows Server 2008 R2 and Windows 7:

a Display Control Panel.
b Select Network and Internet.
c Select Network and Sharing Center.
d Select Connect to a network.
e Select xxxxxxxx (xxxxxxxx indicates a wireless device’s SSID which you use) from the 

network items listed in the available network list, and click Connect.
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2 Check the IP address assigned by AutoIP on the printer.
a On the operator panel, press the  (Menu) button.
b Select Admin Menu, and then press the  button.
c Select Network Setup, and then press the  button.
d Select TCP/IP, and then press the  button.
e Select IPv4, and then press the  button.
f Select IP Address, and then press the  button.

(Default IP address range: 169.254.xxx.yyy)

3 Ensure that the IP Address on your computer is assigned by DHCP.

4 Launch your web browser.

5 Enter the IP address of the printer in the address bar, and then press the Enter key.
CentreWare Internet Services page appears.

IP Address
169.254.000.041*
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6 Create wireless setting of the printer on CentreWare Internet Services.

7 Reboot the printer.

8 Restore the wireless settings on your computer.

NOTE: 
• If the operating system on your computer provides a wireless configuration software, use it to change the 

wireless settings. See the instructions below.
For Windows XP and Windows Server 2003:

a Select Network Connections from Control Panel.
b Right-click Wireless Network Connection and select Properties.
c Select Wireless Networks tab.
d Ensure that the check box for Use Windows to configure my wireless network settings is 

selected.
e Click Advanced.
f You can either set the printer to the ad-hoc mode or the infrastructure mode.
• For Ad hoc mode:

Select Computer-to-computer (ad hoc) networks only and close the dialog box.

• For Infrastructure mode:
Select Access point (Infrastructure) networks only and close the dialog box.

g Click Add to display Wireless network properties.
h Enter the setting that you will send to the printer and click OK.
i Click Move up to move the setting to the top of the list.
j Click OK to close the Wireless Network Connection Properties dialog box. 
For Windows Vista:

a Display Control Panel.
b Select Network and Internet.
c Select Network and Sharing Center.
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d Select Connect to a network.
e Select the network, and then click Connect.
f Click Close in the dialog box after confirming the connection is a success.
For Windows Server 2008:

a Display Control Panel.
b Select Network and Internet.
c Select Network and Sharing Center.
d Select Connect to a network.
e Select the network, and then click Connect.
f Click Close in the dialog box after confirming the connection is a success.
For Windows Server 2008 R2 and Windows 7:

a Display Control Panel.
b Select Network and Internet.
c Select Network and Sharing Center.
d Select Connect to a network.
e Select the network, and then click Connect.
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• For Fixed IP Networks:

1 Set up your computer for wireless connectivity:

NOTE: 
• If the operating system on your computer provides a wireless configuration software, use it to change the 

wireless settings. See the instructions below.
For Windows XP and Windows Server 2003:

a Select Network Connections from Control Panel.
b Right-click Wireless Network Connection and select Properties.
c Select the Wireless Networks tab.
d Ensure that the check box for Use Windows to configure my wireless network settings is 

selected.

NOTE: 
• Be sure to write down the current wireless computer settings in step f and step h so that you can restore 

them later.

e Click the Advanced button.
f Select Computer-to-computer (ad hoc) networks only and close the Advanced dialog 

box.
g Click the Add button to display Wireless network properties.
h On the Association tab, enter the following information and click OK.

Network name (SSID): xxxxxxxx (xxxxxxxx indicates a wireless device’s SSID which 
you use)

Network Authentication: Open

Data encryption: Disabled

i Click the Move up button to move the newly added SSID to the top of the list.
j Click OK to close the Wireless Network Connection Properties dialog box.
For Windows Vista:
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a Display Control Panel.
b Select Network and Internet.
c Select Network and Sharing Center.
d Select Connect to a network.
e Select xxxxxxxx (xxxxxxxx indicates a wireless device’s SSID which you use) from the 

network items listed in the available network list, and click Connect.
f Click Close in the dialog box after confirming the connection is a success.
For Windows Server 2008:

a Display Control Panel.
b Select Network and Internet.
c Select Network and Sharing Center.
d Select Connect to a network.
e Select xxxxxxxx (xxxxxxxx indicates a wireless device’s SSID which you use) from the 

network items listed in the available network list, and click Connect.
f Click Close in the dialog box after confirming the connection is a success.
For Windows Server 2008 R2 and Windows 7:

a Display Control Panel.
b Select Network and Internet.
c Select Network and Sharing Center.
d Select Connect to a network.
e Select xxxxxxxx (xxxxxxxx indicates a wireless device’s SSID which you use) from the 

network items listed in the available network list, and click Connect.

2 Check the IP address on your computer.

3 Set the IP address on the printer.
See "Assigning an IP Address (for IPv4 Mode)" on page 59.

4 Launch your web browser.
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5 Enter the IP address of the printer in the address bar, and then press the Enter key.
CentreWare Internet Services page appears.

6 Change the wireless setting of the printer on CentreWare Internet Services.

7 Reboot the printer.

8 Restore the wireless settings on your computer.

NOTE: 
• If the operating system on your computer provides a wireless configuration software, use it to change the 

wireless settings. Or you can change the wireless settings using the tool provided with the operating 
system. See the instructions below.

For Windows XP and Windows Server 2003:

a Select Network Connections from Control Panel.
b Right-click Wireless Network Connection and select Properties.
c Select Wireless Networks tab.
d Ensure that the check box for Use Windows to configure my wireless network settings is 

selected.
e Click Advanced.
f You can either set the printer to the ad-hoc mode or the infrastructure mode.
• For Ad hoc mode:

Select Computer-to-computer (ad hoc) networks only and close the dialog box.

• For Infrastructure mode:
Select Access point (Infrastructure) networks only and close the dialog box.

g Click Add to display Wireless network properties.
h Enter the setting that you will send to the printer and click OK.
i Click Move up to move the setting to the top of the list.
j Click OK to close the Wireless Network Connection Properties dialog box. 
For Windows Vista:
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a Display Control Panel.
b Select Network and Internet.
c Select Network and Sharing Center.
d Select Connect to a network.
e Select the network, and then click Connect.
f Click Close in the dialog box after confirming the connection is a success.
For Windows Server 2008:

a Display Control Panel.
b Select Network and Internet.
c Select Network and Sharing Center.
d Select Connect to a network.
e Select the network, and then click Connect.
f Click Close in the dialog box after confirming the connection is a success.
For Windows Server 2008 R2 and Windows 7:

a Display Control Panel.
b Select Network and Internet.
c Select Network and Sharing Center.
d Select Connect to a network.
e Select the network, and then click Connect.
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Setting Up for Shared Printing
You can share your new printer on the network using the Software Pack CD-ROM that shipped with 
your printer, or using Windows Point and Print or peer-to-peer method. However, if you use either of 
the Microsoft methods you will not get features such as the SimpleMonitor and other printer utilities, 
which will get installed with the Software Pack CD-ROM.
If you want to use the printer on a network, share the printer and install its drivers on all the computers 
on the network.

NOTE: 
• You need to purchase a Ethernet cable separately for shared printing.

• For Windows XP, Windows XP 64-bit Edition, Windows Server 2003, and 
Windows Server 2003 x64 Edition

1 Click Start (start for Windows XP) → Printers and Faxes.

2 Right-click this printer icon and select Properties.

3 From the Sharing tab, select the Share this printer check box, and then enter a name in the 
Share name text box.

4 Click Additional Drivers and select the operating systems of all network clients using this 
printer.

5 Click OK.
If the files are not present in your computer, and then you will be prompted to insert the server 
operating system CD.

6 Click Apply, and then click OK.

• For Windows Vista and Windows Vista 64-bit Edition

1 Click Start → Control Panel → Hardware and Sound → Printers.

2 Right-click the printer icon and select Sharing.

3 Click Change sharing options button.

4 The "Windows needs your permission to continue" appears.

5 Click Continue button.

6 Select the Share this printer check box, and then enter a name in the Share name text box.

7 Select Additional Drivers and select the operating systems of all network clients using this 
printer.

8 Click OK.

9 Click Apply, and then click OK.
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• For Windows Server 2008 and Windows Server 2008 64-bit Edition

1 Click Start → Control Panel → Hardware and Sound → Printers.

2 Right-click the printer icon and select Sharing.

3 Select the Share this printer check box, and then enter a name in the Share name text box.

4 Click Additional Drivers and select the operating systems of all network clients using this 
printer.

5 Click OK.

6 Click Apply, and then click OK.

• For Windows 7, Windows 7 64-bit Edition, and Windows Server 2008 R2

1 Click Start → Devices and Printers.

2 Right-click the printer icon and select Printer properties.

3 On the Sharing tab, select the Share this printer check box, and then enter a name in the 
Share name text box.

4 Click Additional Drivers and select the operating systems of all network clients using this 
printer.

5 Click OK.

6 Click Apply, and then click OK.
To check that the printer is shared:

• Ensure that the printer object in the Printers, Printers and Faxes or Devices and Printers 
folder is shared. The share icon is shown under the printer icon.

• Browse Network or My Network Places. Find the host name of the server and look for the 
shared name you assigned to the printer.

Now that the printer is shared, you can install the printer on network clients using the Point and Print 
method or the peer-to-peer method.

Point and Print
Point and Print is a Microsoft Windows technology that allows you to connect to a remote printer. This 
feature automatically downloads and installs the print driver.
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• For Windows XP, Windows XP 64-bit Edition, Windows Server 2003, and 
Windows Server 2003 x64 Edition

1 On the Windows desktop of the client computer, double-click My Network Places.

2 Locate the host name of the server computer, and then double-click the host name.

3 Right-click the shared printer name, and then click Connect.

Wait for the driver information to be copied from the server computer to the client computer, and 
for a new printer object to be added to the Printers and Faxes folder. The time taken to copy 
varies based on the network traffic.

Close My Network Places.

4 Print a test page to verify installation.
a Click start (Start for Windows Server 2003/Windows Server 2003 x64 Edition) → Printers 

and Faxes.
b Select the printer you have installed.
c Click File → Properties.
d On the General tab, click Print Test Page.

When a test page is printed successfully, installation is complete.
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• For Windows Vista and Windows Vista 64-bit Edition

1 Click Start → Network.

2 Locate and double-click the host name of the server computer.

3 Right-click the shared printer name, and then click Connect.

4 Click Install driver.

5 Click Continue in the User Account Control dialog box.
Wait until the driver is copied from the server to the client computer. A new printer object is added 
to the Printers folder. The duration of this procedure may vary based on the network traffic.

6 Print a test page to verify installation.
a Click Start → Control Panel → Hardware and Sound.
b Select Printers.
c Right-click the printer you just created and select Properties.
d On the General tab, click Print Test Page.

When a test page is printed successfully, installation is complete.

• For Windows Server 2008 and Windows Server 2008 64-bit Edition

1 Click Start → Network.

2 Locate the host name of the server computer, and then double-click the host name.

3 Right-click the shared printer name, and then click Connect.

4 Click Install driver.

5 Wait until the driver is copied from the server to the client computer. A new printer object will be 
added to the Printers folder. The time taken for these activities varies based on network traffic.

6 Print a test page to verify installation.
a Click Start → Control Panel.
b Select Hardware and Sound.
c Select Printers.
d Right-click the printer you just created and select Properties.
e On the General tab, click Print Test Page.

When a test page is printed successfully, installation is complete.
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• For Windows 7, Windows 7 64-bit Edition, and Windows Server 2008 R2

1 Click Start → Network.

2 Locate the host name of the server computer, and then double-click the host name.

3 Right-click the shared printer name, and then click Connect.

4 Click Install driver.

5 Wait until the driver is copied from the server to the client computer. A new printer object will be 
added to the Devices and Printers folder. The time taken for these activities varies based on 
network traffic.

6 Print a test page to verify installation.
a Click Start → Devices and Printers.
b Right-click the printer you just created and select Printer properties.
c On the General tab, click Print Test Page.

When a test page is printed successfully, installation is complete.

Peer-to-Peer
If you use the peer-to-peer method, the print driver is installed on each client computer. The client 
computers can modify the driver and handle the print jobs.
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• For Windows XP, Windows XP 64-bit Edition, Windows Server 2003, and 
Windows Server 2003 x64 Edition

1 Click start (Start for Windows Server 2003/Windows Server 2003 x64 Edition) → Printers and 
Faxes.

2 Click Add a printer (Add Printer for Windows Server 2003/Windows Server 2003 x64 Edition) 
to launch the Add Printer Wizard.

3 Click Next.

4 Select A network printer, or a printer attached to another computer, and then click Next. 

5 Click Browse for a printer, and then click Next.

6 Select the printer, and then click Next. If the printer is not listed, click Back and enter in the path 
of the printer in the text box.

The server host name is the name of the server computer that identifies it to the network. The 
shared printer name is the name assigned during the server installation process.

If this is a new printer, you may be prompted to install a print driver. If no system driver is 
available, specify the location where the driver is available.

7 Select Yes if you want this printer to be set as the default printer, and then click Next.

8 Click Finish.

For example:\\<server host name>\<shared printer name>
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• For Windows Vista and Windows Vista 64-bit Edition

1 Click Start → Control Panel → Hardware and Sound → Printers.

2 Click Add a printer to launch the Add Printer wizard.

3 Select Add a network, wireless or Bluetooth printer. If the printer is listed, select the printer 
and click Next, or select The printer that I want isn't listed and enter in the path of the printer in 
the Select a shared printer by name text box and click Next.

The server host name is the name of the server computer that identifies it on the network. The 
shared printer name is the name assigned during the server installation process.

4 If this is a new printer, you may be prompted to install a print driver. If no system driver is 
available, specify the location where the driver is available.

5 Confirm the printer name, and then select whether to use this printer as the default printer and 
click Next.

6 If you want to verify installation, click Print a test page.

7 Click Finish.
When a test page is printed successfully, installation is complete.

For example:\\<server host name>\<shared printer name>
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• For Windows Server 2008 and Windows Server 2008 64-bit Edition

1 Click Start → Control Panel → Hardware and Sound → Printers.

2 Click Add a printer to launch the Add Printer wizard.

3 Select Add a network, wireless or Bluetooth printer. If the printer is listed, select the printer 
and click Next, or select The printer that I want isn't listed and enter in the path of the printer in 
the Select a shared printer by name text box and click Next.
For example: \\<server host name>\<shared printer name>

The server host name is the name of the server computer that identifies it on the network. The 
shared printer name is the name assigned during the server installation process.

4 If this is a new printer, you may be prompted to install a print driver. If no system driver is 
available, specify the location where the driver is available.

5 Confirm the printer name, and then select whether to use this printer as the default printer and 
click Next.

6 Select whether to share this printer or not.

7 If you want to verify installation, click Print a test page.

8 Click Finish.
When a test page is printed successfully, installation is complete.

• For Windows 7, Windows 7 64-bit Edition, and Windows Server 2008 R2

1 Click Start → Devices and Printers.

2 Click Add a printer to launch the Add Printer wizard.

3 Select Add a network, wireless or Bluetooth printer. If the printer is listed, select the printer 
and click Next, or select The printer that I want isn't listed. Click Select a shared printer by 
name and enter in the path of the printer in the text box, and then click Next.
For example: \\<server host name>\<shared printer name>

The server host name is the name of the server computer that identifies it to the network. The 
shared printer name is the name assigned during the server installation process.

4 If this is a new printer, you may be prompted to install a print driver. If no system driver is 
available, you need to specify the path to the available drivers.

5 Confirm the printer name, and then click Next.

6 Select whether to use this printer as the default printer, and then click Next.

7 If you want to verify installation, click Print a test page.

8 Click Finish.
When a test page is printed successfully, installation is complete.
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Installing Print Driver on Computers Running Mac 
OS X
This section includes:

• "Installing the Driver" on page 104
103 Network Basics



Installing the Driver
The following procedure uses Mac OS X 10.6 as an example.

1 Run the Software Pack CD-ROM on the Mac OS X.

2 Double-click the CP205 CP105 Print Installer icon.

3 Click Continue on the Introduction screen.

4 Select a language for the Software License Agreement.

5 After reading the Software License Agreement, click Continue.

6 If you agree to the terms of the Software License Agreement, click Agree to continue the 
installation process.

7 Click Install to perform the standard installation. 

8 Enter the administrator's name and password, and then click OK.

9 Click Close to complete installation.

Adding a Printer on Mac OS X 10.5.8/10.6 or Later Version(s)

• When Using a USB connection

1 Turn off the printer and your computer.

2 Connect the printer and your computer with the USB cable.

3 Turn on the printer and your computer.

4 Display System Preferences, and then click Print & Fax.

5 Confirm your USB printer is added to Print & Fax in System Preferences.
If your USB printer is not displayed, execute the following procedures.

6 Click the plus (+) sign, and then click Default.

7 Select the printer connected via USB from the Printer Name list.
Name, Location, and Print Using are automatically entered.

8 Click Add.
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• When Using Bonjour

1 Turn on the printer.

2 Ensure that your computer is connected to the network.
If you use wired connection, ensure that the Ethernet cable is connected between the printer and 
the network.

If you use wireless connection, ensure that wireless connection is configured properly on your 
computer and printer.

3 Display System Preferences, and then click Print & Fax.

4 Click the plus (+) sign, and then click Default.

5 Select the printer connected via Bonjour from the Printer Name list. 
Name and Print Using are automatically entered.

6 Click Add.

• When Using IP Printing

1 Turn on the printer.

2 Ensure that your computer is connected to the network.
If you use wired connection, ensure that the Ethernet cable is connected between the printer and 
the network.

If you use wireless connection, ensure that wireless connection is configured properly on your 
computer and printer.

3 Display System Preferences, and then click Print & Fax.

4 Click the plus (+) sign, and then click IP.

5 Select Line Printer Daemon - LPD for Protocol.

6 Enter the IP address of the printer in the Address area.

7 Select the model of your printer for Print Using.

NOTE: 
• When the printing is set up using IP printing, the queue name is displayed as blank. You do not need to 

specify it.

8 Click Add.
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Adding a Printer on Mac OS X 10.4.11

• When Using a USB Connection

1 Turn off the printer and your computer.

2 Connect the printer and your computer with the USB cable.

3 Turn on the printer and your computer.

4 Start Printer Setup Utility.

NOTE: 
• You can find Printer Setup Utility in the Utilities folder in Applications.

5 Confirm your USB printer is added to Printer List.
If your USB printer is not displayed, execute the following procedures.

6 Click Add.

7 Click Default Browser in the Printer Browser dialog box.

8 Select the printer connected via USB from the Printer Name list.
Name, Location and Print Using are automatically entered.

9 Click Add.

• When Using Bonjour

1 Turn on the printer.

2 Ensure that your computer is connected to the network.
If you use wired connection, ensure that the Ethernet cable is connected between the printer and 
the network.

If you use wireless connection, ensure that wireless connection is configured properly on your 
computer and printer.

3 Start Printer Setup Utility.

NOTE: 
• You can find Printer Setup Utility in the Utilities folder in Applications.

4 Click Add.

5 Click Default Browser in the Printer Browser dialog box.

6 Select the printer connected via Bonjour from the Printer Name list.
Name and Print Using are automatically entered.

7 Click Add.
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• When Using IP Printing

1 Turn on the printer.

2 Ensure that your computer is connected to the network.
If you use wired connection, ensure that the Ethernet cable is connected between the printer and 
the network.

If you use wireless connection, ensure that wireless connection is configured properly on your 
computer and printer.

3 Start Printer Setup Utility.

NOTE: 
• You can find Printer Setup Utility in the Utilities folder in Applications.

4 Click Add.

5 Click IP Printer in the Printer Browser dialog box.

6 Select Line Printer Daemon - LPD for Protocol.

7 Enter the IP address of the printer in the Address area.

8 Select FX for Print Using, and then select the model of your printer.

NOTE: 
• When the printing is set up using IP printing, the queue name is displayed as blank. You do not need to 

specify it. 

9 Click Add.
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Adding a Printer on Mac OS X 10.3.9

• When Using a USB Connection

1 Turn off the printer and your computer.

2 Connect the printer and your computer with the USB cable.

3 Turn on the printer and your computer.

4 Start Printer Setup Utility.

NOTE: 
• You can find Printer Setup Utility in the Utilities folder in Applications.

5 Confirm your USB printer is added to Printer List.
If your USB printer is not displayed, execute the following procedures.

6 Click Add.

7 Select USB from the menu.

8 Select the printer from the Product list.
Printer Model is automatically selected.

9 Click Add.

• When Using Rendezvous (Bonjour)

1 Turn on the printer.

2 Ensure that your computer is connected to the network.
If you use wired connection, ensure that the Ethernet cable is connected between the printer and 
the network.

If you use wireless connection, ensure that wireless connection is configured properly on your 
computer and printer.

3 Start Printer Setup Utility.

NOTE: 
• You can find Printer Setup Utility in the Utilities folder in Applications.

4 Click Add.

5 Select Rendezvous from the menu.

6 Select the printer you want to install from the Name list.
Printer Model is automatically selected.

7 Select the printer model from the Model Name list.

8 Click Add.
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• When Using IP Printing

1 Turn on the printer.

2 Ensure that your computer is connected to the network.
If you use wired connection, ensure that the Ethernet cable is connected between the printer and 
the network.

If you use wireless connection, ensure that wireless connection is configured properly on your 
computer and printer.

3 Start Printer Setup Utility.

NOTE: 
• You can find Printer Setup Utility in the Utilities folder in Applications.

4 Click Add.

5 Click IP Printing from the menu.

6 Select LPD/LPR for Printer Type.

7 Enter the IP address of the printer in the Printer Address area.

8 Select FX for Printer Model, and then select the model of your printer.

NOTE: 
• When the printing is set up using IP printing, the queue name is displayed as blank. You do not need to 

specify it. 

9 Click Add.
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5
Printing Basics

This chapter includes:
• "About Print Media" on page 112
• "Supported Print Media" on page 116
• "Loading Print Media" on page 122
• "Printing" on page 145
• "Printing with Web Services on Devices (WSD)" on page 159
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About Print Media
This section includes:

• "Print Media Usage Guidelines" on page 113
• "Print Media That Can Damage Your Printer" on page 114
• "Print Media Storage Guidelines" on page 115

Using paper that is not appropriate for the printer can cause paper jams, image quality problems, or 
printer failure. To achieve the best performance from your printer, we recommend you to use only the 
paper described in this section.
When using paper other than that recommended, contact the Fuji Xerox local representative office or 
an authorised dealer.
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Print Media Usage Guidelines
The printer tray accommodates most sizes and types of paper and other specialty media. Follow these 
guidelines when loading paper and media in the tray:

• Envelopes can be printed from the multipurpose feeder (MPF) and priority sheet inserter (PSI).
• Fan paper or other specialty media before loading in the paper tray.
• Do not print on label stock once a label has been removed from a sheet.
• Use only paper envelopes. Do not use envelopes with windows, metal clasps, or adhesives with 

release strips.
• Print all envelopes single-sided only. 
• Some wrinkling and embossing may occur when printing envelopes.
• Do not overload the paper tray. Do not load print media above the fill line on the inside of the 

paper width guides.
• Adjust the paper width guides to fit the paper size.
• If excessive jams occur, use paper or other media from a new package.

See also: 
• "Loading Print Media in the Multipurpose Feeder (MPF)" on page 125
• "Loading Print Media in the Priority Sheet Inserter (PSI)" on page 134
• "Loading Envelope in the Multipurpose Feeder (MPF)" on page 129
• "Loading Envelope in the Priority Sheet Inserter (PSI)" on page 136
• "Printing on Custom Size Paper" on page 153

WARNING:
• Do not use conductive paper such as origami paper, carbonic paper or conductively-coated paper. 

When paper jam occurs, it may cause short-circuit and eventually a fire accident.
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Print Media That Can Damage Your Printer
Your printer is designed to use a variety of media types for print jobs. However, some media can 
cause poor output quality, increased paper jams, or damage to your printer.
Unacceptable media includes:

• Rough or porous media
• Plastic media
• Paper that has been folded or wrinkled
• Paper with staples
• Envelopes with windows or metal clasps
• Padded envelopes
• Non-laser glossy or coated paper
• Perforated media

WARNING:
• Do not use conductive paper such as origami paper, carbonic paper or conductively-coated paper. 

When paper jam occurs, it may cause short-circuit and eventually a fire accident.
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Print Media Storage Guidelines
Providing good storage conditions for your paper and other media contributes to optimum print quality.

• Store print media in dark, cool, relatively dry locations. Most paper items are susceptible to 
damage from ultraviolet (UV) and visible light. UV radiation, which is emitted by the sun and 
fluorescent bulbs, is particularly damaging to paper items. The intensity and length of exposure 
to visible light on paper items should be reduced as much as possible.

• Maintain constant temperatures and relative humidity.
• Avoid attics, kitchens, garages, and basements for storing print media. 
• Store print media flat. Print media should be stored on pallets, cartons, shelves, or in cabinets.
• Avoid having food or drinks in the area where print media is stored or handled.
• Do not open sealed packages of paper until you are ready to load them into the printer. Leave 

paper in the original packaging. For most commercial cut-size grades, the ream wrapper 
contains an inner lining that protects the paper from moisture loss or gain.

• Leave the media inside the bag until you are ready to use it; reinsert unused media in the bag 
and reseal it for protection. Some specialty media is packaged inside resealable plastic bags. 
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Supported Print Media
Using unsuitable print media may lead to paper jams, poor print quality, breakdown and damage to 
your printer. To use the features of this printer effectively, use the suggested print media that is 
recommended here.

IMPORTANT: 
• The toner may come off the print media, if it gets wet by water, rain, steam and so on. For details, contact the 

Fuji Xerox local representative office or an authorized dealer.
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Usable Print Media
The types of print media that can be used on this printer are as follows:
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Multipurpose Feeder (MPF)

Paper Size A4 SEF (210 × 297 mm)

B5 SEF (182 × 257 mm)

A5 SEF (148 × 210 mm)

Letter SEF (8.5 × 11 inches)

Legal SEF (8.5 × 14 inches)

Folio SEF (8.5 × 13 inches)

Executive SEF (7.25 × 10.5 inches)

C5 SEF (162 × 229 mm)

Monarch SEF (3.875 × 7.5 inches)

Monarch LEF (7.5 × 3.875 inches)*1

# 10 Env SEF (4.125 × 9.5 inches)

DL SEF (110 × 220 mm)

DL LEF (220 × 110 mm)*1

Yougata 2 SEF (114 × 162 mm)

Yougata 2 LEF (162 × 114 mm)*1

Yougata 3 SEF (98 × 148 mm)

Yougata 3 LEF (148 × 98 mm)*1

Yougata 4 SEF (105 × 235 mm)

Younaga 3 SEF (120 × 235 mm)

Nagagata 3 SEF (120 × 235 mm)

Postcard SEF (100 × 148 mm)

Postcard SEF (148 × 200 mm)

Custom Size:
Width: 76.2–215.9 mm (3–8.5 inches)*2

Length: 127–355.6 mm (5 –14 inches)*3

Paper Type (Weight) Plain

Bond

Lightweight Cardstock

Japanese Glossy Cardstock

Lightweight Glossy Cardstock

Labels

Envelope

Recycled

Postcard

Letterhead

Pre-Printed

Hole Punched

Colored

Special

Custom Type
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Loading Capacity 150 sheets of standard paper
*1 Monarch, DL, Yougata 2, and Yougata 3 envelopes can be supported by LEF with their flap open.
*2 The maximum width is 220 mm for DL LEF.
*3 The minimum length is 3.875 inches for Monarch LEF, 110 mm for DL LEF, 114 mm for Yougata 2 LEF, 

and 98 mm for Yougata 3 LEF.
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Priority Sheet Inserter (PSI)

NOTE: 
• SEF and LEF indicate the paper feed direction; SEF stands for short-edge feed. LEF stands for long-

edge feed.
• Use only laser print media. Do not use ink jet paper in this printer.

See also: 
• "Loading Print Media in the Multipurpose Feeder (MPF)" on page 125
• "Loading Print Media in the Priority Sheet Inserter (PSI)" on page 134

Paper Size A4 SEF (210 × 297 mm)

B5 SEF (182 × 257 mm)

A5 SEF (148 × 210 mm)

Letter SEF (8.5 × 11 inches)

Legal SEF (8.5 × 14 inches)

Folio SEF (8.5 × 13 inches)

Executive SEF (7.25 × 10.5 inches)

C5 SEF (162 × 229 mm)

Monarch SEF (3.875 × 7.5 inches)

# 10 Env SEF (4.125 × 9.5 inches)

DL SEF (110 × 220 mm)

Yougata 4 SEF (105 × 235 mm)

Younaga 3 SEF (120 × 235 mm)

Nagagata 3 SEF (120 × 235 mm)

Postcard SEF (148 × 200 mm)

Custom Size:
Width: 98.4–215.9 mm (3.875–8.5 inches)
Length: 190.5–355.6 mm (7.5 –14 inches)

Paper Type (Weight) Plain

Bond

Lightweight Cardstock

Japanese Glossy Cardstock

Lightweight Glossy Cardstock

Labels

Envelope

Recycled

Postcard

Letterhead

Pre-Printed

Hole Punched

Colored

Special

Custom Type

Loading Capacity 10 sheets of standard paper
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• "Loading Envelope in the Multipurpose Feeder (MPF)" on page 129
• "Loading Envelope in the Priority Sheet Inserter (PSI)" on page 136
• "Loading Postcard in the Multipurpose Feeder (MPF)" on page 132
• "Loading W-Postcard in the Priority Sheet Inserter (PSI)" on page 138
• "Loading Letterhead in the Multipurpose Feeder (MPF)" on page 133
• "Loading Letterhead in the Priority Sheet Inserter (PSI)" on page 139

Printing on print media that differs from the paper size or paper type selected on the print driver may 
lead to paper jams. To ensure that printing is correctly done, select the correct paper size and paper 
type.
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Loading Print Media
Loading print media properly helps prevent jams and ensures trouble-free printing.
Before loading print media, identify the recommended print side of the print media. This information is 
usually on the print media package.

NOTE: 
• After loading paper in the feeder, specify the same paper type on the print driver.
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Capacity
Multipurpose feeder (MPF) can hold:

• 150 sheets of standard paper
• 16.2 mm (0.64 inches) of thick paper
• One sheet of coated paper
• 16.2 mm (0.64 inches) of post cards
• Five envelopes
• 16.2 mm (0.64 inches) of labels

Priority sheet inserter (PSI) can hold:
• 10 sheets of standard paper or one sheet of other paper
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Print Media Dimensions
The MPF accepts print media within the following dimensions: 

• Width: 76.2 –215.9 mm (3.00–8.50 inches)
• Length: 127–355.6 mm (5.00–14.00 inches)

NOTE: 
• The maximum width is 220 mm for DL LEF.
• The minimum length is 3.875 inches for Monarch LEF, 110 mm for DL LEF, 114 mm for Yougata 2 LEF, and 98 

mm for Yougata 3 LEF.

The PSI accepts print media within the following dimensions:
• Width: 98.4–215.9 mm (3.875–8.50 inches)
• Length: 190.5–355.6 mm (7.50–14.00 inches)
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Loading Print Media in the Multipurpose Feeder (MPF)
NOTE: 
• To avoid paper jams, do not remove the priority sheet inserter (PSI) while printing is in progress.
• Use only laser print media. Do not use ink jet paper in this printer.

1 Open the front cover.

NOTE: 
• When you use the MPF for the first time, open the front cover by pulling out the instruction sheet.

2 Pull the PSI out.

NOTE: 
• When you use the MPF for the first time, remove the instruction sheet attached to the PSI with adhesive 

tape.
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• Read the instruction sheet before you use the PSI.

3 Pull the slide bar forward until it stops.

4 Pull the length guide forward until it stops.

5 Adjust the paper width guides to their maximum width.

6 Before loading the print media, flex the sheets back and forth, and then fan them. Straighten the 
edges of the stack on a level surface.
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7 Load print media on the MPF with the top edge first and with the recommended print side facing 
up.

8 Adjust the paper width guides until they rest lightly against the edges of the stack of print media.

9 Slide the length guide towards the printer until it touches the print media.
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NOTE: 
• Depending on the size of print media, first slide the slide bar backward until it stops, and then pinch the 

length guide and slide it backward until it touches print media.

10 Insert the PSI into the printer and then align the PSI to the marking on the MPF.
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11 Open the output tray extension.

12 Select the paper type from the print driver if the loaded print media is not standard plain paper. If 
a user-specified print media is loaded in the MPF, you must specify the paper size setting by 
using the print driver.

NOTE: 
• For more information about setting the paper size and type on the print driver, refer to the online Help 

provided for the print driver.

NOTE: 
• For standard-size paper, adjust the guides first and then set paper.

Loading Envelope in the Multipurpose Feeder (MPF)
NOTE: 
• When you print on envelopes, be sure to specify the envelope setting on the print driver. If not specified, the 

print image will be rotated 180 degrees.
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• When Loading # 10, DL, Monarch, Yougata 2/3/4, or Younaga 3
Load envelopes with the side to be printed on facing up, the flap side facing down, and the flap turned 
to the right.

To prevent DL, Monarch, Yougata 2, and Yougata 3 from being wrinkled, they are recommended to be 
loaded with the print-side facing up, flap opened, and facing you.

NOTE: 
• When you load the envelopes in the long-edge feed (LEF) orientation, be sure to specify the landscape 

orientation on the print driver.
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• When Loading C5 or Nagagata 3
Load envelopes with the side to be printed on facing up, flap opened, and facing you.

IMPORTANT: 
• Never use envelopes with windows, or coated linings. These lead to paper jams and can cause damage to the 

printer.

NOTE: 
• If you do not load envelopes in the MPF right after they have been removed from the packaging, they may 

bulge. To avoid jams, flatten them as shown below when loading them in the MPF.

• If envelopes are still not fed correctly, add some bending to the flap of the envelopes as shown in the following 
illustration.
The amount of the bending shall be 5 mm (0.20 inches) or less.
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• To confirm the correct orientation of each print media such as envelopes, see the instruction on the 
Envelope/Paper Setup Navigator on the print driver.

Loading Postcard in the Multipurpose Feeder (MPF)
NOTE: 
• When you print on postcards, be sure to specify the postcard setting on the print driver to get the optimum 

print result.

• When Loading Postcard
Load the postcard with the side to be printed on facing up, and the top edge of the postcard in first.
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• When Loading W-Postcard
Load the w-postcard with the side to be printed on facing up, and the left edge of the w-postcard in 
first.

NOTE: 
• To confirm the correct orientation of each print media such as postcards, see the instruction on the 

Envelope/Paper Setup Navigator on the print driver.

Loading Letterhead in the Multipurpose Feeder (MPF)
Load the letterhead in the printer with the print side facing up. Ensure that the title on the letterhead 
enters the printer first.
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Loading Print Media in the Priority Sheet Inserter (PSI)
NOTE: 
• To avoid paper jams, do not remove the PSI while printing is in progress.
• Use only laser print media. Do not use ink jet paper in this printer.

1 Open the front cover.

2 Slide the PSI forward, and then align the PSI to the marking on the MPF.

3 Adjust the paper width guides to their maximum width.

4 Before loading the print media, flex the sheets back and forth, and then fan them. Straighten the 
edges of the stack on a level surface.
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5 Load print media on the PSI with the top edge first and with the recommended print side facing 
up.

6 Adjust the paper width guides until they rest lightly against the edges of the stack of print media.

7 Open the output tray extension.

8 Select the paper type from the print driver if the loaded print media is not standard plain paper. If 
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a user-specified print media is loaded in the PSI, you must specify the paper size setting by using 
the print driver.

NOTE: 
• For more information about setting the paper size and type on the print driver, refer to the online Help provided 

for the print driver.

Loading Envelope in the Priority Sheet Inserter (PSI)
NOTE: 
• Be sure to fully insert the envelope until it stops. Otherwise, print media that is loaded on the MPF will be fed.
• When you print on envelopes, be sure to specify the envelope setting on the print driver. If not specified, the 

print image will be rotated 180 degrees.

• When Loading # 10, DL, Monarch, Yougata 4, or Younaga 3
Load the envelope with the side to be printed on facing up, the flap side facing down, and the flap 
turned to the right.
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• When Loading C5 or Nagagata 3
Load the envelope with the side to be printed on facing up, flap opened, and facing you.

IMPORTANT: 
• Never use envelopes with windows, or coated linings. These lead to paper jams and can cause damage to the 

printer.

NOTE: 
• If you do not load envelopes in the PSI right after they have been removed from the packaging, they may 

bulge. To avoid jams, flatten them as shown below when loading them in the PSI.

• If envelopes are still not fed correctly, add some bending to the flap of the envelopes as shown in the following 
illustration.
The amount of the bending shall be 5 mm (0.20 inches) or less.
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• To confirm the correct orientation of each print media such as envelopes, see the instruction on the 
Envelope/Paper Setup Navigator on the print driver.

Loading W-Postcard in the Priority Sheet Inserter (PSI)
NOTE: 
• When you print on the w-postcard, be sure to specify the w-postcard setting on the print driver to get the 

optimum print result.

Load the w-postcard with the side to be printed on facing up, and the left edge of the w-postcard in 
first.

NOTE: 
• To confirm the correct orientation of each print media such as w-postcards, see the instruction on the 

Envelope/Paper Setup Navigator on the print driver.
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Loading Letterhead in the Priority Sheet Inserter (PSI)
Load the letterhead in the printer with the print side facing up. Ensure that the title on the letterhead 
enters the printer first.
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Manual Duplex Printing (Windows Print Driver Only)
This section includes:

• "Operations on Your Computer" on page 141
• "Loading Print Media in the Multipurpose Feeder (MPF)" on page 142
• "Loading Print Media in the Priority Sheet Inserter (PSI)" on page 143

NOTE: 
• When printing on curled paper, straighten the paper and then insert it into the feeder.

When you start manual duplex printing, the instruction window appears. Note that the window cannot 
be reopened once it is closed. Do not close the window until duplex printing is complete.
Manual duplex printing can be done using the multipurpose feeder (MPF) or the priority sheet inserter 
(PSI).
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Operations on Your Computer
The following procedure uses Microsoft® Windows® XP WordPad as an example.

NOTE: 
• The way to display the printer Properties/Printing Preferences dialog box differs according to the application 

software. Refer to the manual of your respective application software.

1 From the File menu, select Print.

2 Select the printer from the Select Printer list box, and then click Preferences.

3 The Paper / Output tab appears.
From 2 Sided Print, select either 2 Sided, Flip on Short Edge or 2 Sided Print to define the 
way 2-sided print pages are bound. 

4 From Paper Size, select the size of the document to be printed.

5 From Paper Type, select the paper type to be used.

6 Click OK to close the Printing Preferences dialog box.

7 Click Print in the Print dialog box to start printing.

IMPORTANT: 
• When you start manual duplex printing, the instruction window appears. Note that the window cannot be 

reopened once it is closed. Do not close the window until duplex printing is complete.

3

4

5
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Loading Print Media in the Multipurpose Feeder (MPF)

1 First print the even pages (rear sides).
For a six page document, rear sides are printed in the order of page 6, page 4, then page 2.

The  (Error) indicator lights and the Insert Output into paper tray message appears 
on the LCD panel when the even pages finish printing.

2 After the even pages are printed, remove the paper stack from the center output tray.

NOTE: 
• Warped or curled prints can cause paper jams. Straighten them before setting them.

3 Stack the prints and set them as they are (with the blank side facing up) into the MPF, and then 
press the  button.
Pages are printed in the order of page 1 (rear of page 2), page 3 (rear of page 4), and then page 
5 (rear of page 6).

NOTE: 
• Printing on both sides of the paper is not possible if the document consists of various sizes of paper.
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Loading Print Media in the Priority Sheet Inserter (PSI)

1 First print the even pages (rear sides).
For a six page document, even pages are printed in the order page 6, page 4, then page 2.

The  (Error) indicator lights and the Insert Output into paper tray message appears 
on the LCD panel when the even pages finish printing.

2 After the even pages are printed, remove the paper stack from the center output tray.

NOTE: 
• Warped or curled prints can cause paper jams. Straighten them before setting them.

3 Stack the prints and set them as they are (with the blank side face up) into the PSI, and then 
press the  button.
Pages are printed in order of page 1 (rear of page 2), page 3 (rear of page 4), and then page 5 
(rear of page 6).

NOTE: 
• Printing on both sides of the paper is not possible if the document consists of various sizes of paper.
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Using the Output Tray Extension
The output tray extension is designed to prevent print media from falling from the printer after the print 
job is complete.
Before printing a document, ensure that the output tray extension is opened.
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Printing
This section covers how to print certain lists of information from your printer and how to cancel a job.
This section includes:

• "Sending a Job to Print" on page 146
• "Canceling a Print Job" on page 147
• "Selecting Printing Options" on page 148
• "Printing Custom Size Paper" on page 153
• "Checking Status of Print Data" on page 155
• "Printing a Report Page" on page 156
• "Printer Settings" on page 157
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Sending a Job to Print
Install the print driver to use all the features of the printer. When you choose Print from a software 
program, a window representing the print driver opens. Select the appropriate settings for the specific 
job you are sending to print. Print settings selected from the driver have precedence over the default 
menu settings selected from the operator panel or Printer Setting Utility.
You may need to click Preferences from the initial Print dialog box to see all the available system 
settings you can change. If you are not familiar with a feature in the print driver window, open the 
online Help for more information.
To print a job from a typical Windows application:

1 Open the file you want to print.

2 From the File menu, select Print.

3 Verify that the correct printer is selected in the dialog box. Modify the system settings as needed 
(such as the pages you want to print or the number of copies).

4 To adjust system settings not available from the first screen, such as Quantity, Paper Size, or 
Feed Orientation, click Preferences.
The Printing Preferences dialog box appears.

5 Specify the print settings. For more information, click Help.

6 Click OK to close the Printing Preferences dialog box.

7 Click Print to send the job to the selected printer.
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Canceling a Print Job
There are several methods for canceling a print job.
This section includes:

• "Canceling From the Operator Panel" on page 147
• "Canceling a Job From the Computer Running Windows" on page 147

Canceling From the Operator Panel
To cancel a job after it has started printing:

1 Press the  (Cancel Job) button.

NOTE: 
• Printing is canceled only for the current job. All the following jobs will continue to print.

Canceling a Job From the Computer Running Windows

• Canceling a Job From the Taskbar
When you send a job to print, a small printer icon appears in the right corner of the taskbar.

1 Double-click the printer icon. 
A list of print jobs appears in the printer window.

2 Select the job you want to cancel.

3 Press the Delete key.

• Canceling a Job From the Desktop

1 Minimize all programs to reveal the desktop.
Click start → Printers and Faxes (for Windows XP).

Click Start → Printers and Faxes (for Windows Server® 2003).

Click Start → Devices and Printers (for Windows 7 and Windows Server 2008 R2).

Click Start → Control Panel → Hardware and Sound → Printers (for Windows Vista®).

Click Start → Control Panel → Printer (for Windows Server 2008).

A list of available printers appears. 

2 Double-click the printer you selected when you sent the job.
A list of print jobs appears in the printer window.

3 Select the job you want to cancel.

4 Press the Delete key.
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Selecting Printing Options
This section includes:

• "Selecting Printing Preferences (Windows)" on page 148
• "Selecting Options for an Individual Job (Windows)" on page 149
• "Selecting Options for an Individual Job (Mac OS X)" on page 151

Selecting Printing Preferences (Windows)
Printer preferences control all of your print jobs, unless you override them specifically for a job. For 
example, if you want to use duplex printing for most jobs, set this option in printer settings.
To select printer preferences:

1 Click start → Printers and Faxes (for Windows XP).
Click Start → Printers and Faxes (for Windows Server 2003).

Click Start → Devices and Printers (for Windows 7 and Windows Server 2008 R2).

Click Start → Control Panel → Hardware and Sound → Printers (for Windows Vista).

Click Start → Control Panel → Printer (for Windows Server 2008).

A list of available printers appears. 

2 Right-click the icon for your printer, and then select Printing Preferences.
The FX DocuPrint CP205/FX DocuPrint CP205 w Printing Preferences screen appears.

3 Make selections on the driver tabs, and then click OK to save your selections.

NOTE: 
• For more information about Windows print driver options, click Help on the print driver tab to view the online 

Help.
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Selecting Options for an Individual Job (Windows)
If you want to use special printing options for a particular job, change the driver settings before 
sending the job to the printer. For example, if you want to use Photo print-quality mode for a particular 
graphic, select this setting in the driver before printing that job.

1 With the desired document or graphic open in your application, access the Print dialog box.

2 Select the DocuPrint CP205/CP205 w and click Preferences to open the print driver.

3 Make selections on the driver tabs. See the following table for specific printing options.

NOTE: 
• In Windows, you can save current printing options with a distinctive name and apply them to other print 

jobs. Make selections on the Paper / Output, Image Options, Layout, Watermarks, or Advanced 
Settings tab, and then click Save under Saved Settings on the Paper / Output tab. Click Help for more 
information.

4 Click OK to save your selections.

5 Print the job.
See the following table for specific printing options:

Printing Options for Windows
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Operating System Driver Tab Printing Options
Windows XP, Windows XP 
x 64bit, Windows Server 
2003, Windows Server 
2003 x 64bit, Windows 
Vista, Windows Vista x 
64bit, Windows Server 
2008, Windows Server 
2008 x 64bit, Windows 
Server 2008 R2, Windows 
7, or Windows 7 x 64bit

Paper / Output tab • Saved Settings
• 2 Sided Print
• Output Color
• Quantity
• Collated
• Paper Summary
• Paper Size
• Paper Type
• Feed Orientation
• Envelope/Paper Setup Navigator
• Printer Status
• Defaults

Image Options tab • Output Color
• Output Recognition
• Image Adjustment Mode
• Image Types
• Image Auto Correction
• Image Settings
• Color Balance
• Profile Settings
• Defaults

Layout tab • Image Orientation
• Multiple-Up
• Booklet / Poster / Mixed Document / Rotation
• Fit to New Paper Size
• Specify Zoom
• Image Shift / Print Position
• Defaults

Windows XP, Windows 
Server 2003, Windows 
Vista, Windows Server 
2008, or Windows 7

Watermarks tab • Watermarks
– New Watermark
– Edit Watermark
– Delete Watermark
– Apply to First Page Only

• Annotation
• Defaults

Windows XP, Windows XP 
x 64bit, Windows Server 
2003, Windows Server 
2003 x 64bit, Windows 
Vista, Windows Vista x 
64bit, Windows Server 
2008, Windows Server 
2008 x 64bit, Windows 
Server 2008 R2, Windows 
7, or Windows 7 x 64bit

Advanced Settings tab • Skip Blank Pages
• Draft Mode
• Other Settings (Graphics Settings)

– Items
– Settings for
– Paper Tray Selection Method

• About
• Defaults
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Selecting Options for an Individual Job (Mac OS X)
To select print settings for a particular job, change the driver settings before sending the job to the 
printer.

1 With the document open in your application, click File, and then click Print.

2 Select the DocuPrint CP205/CP205 w from Printer.

3 Select the desired printing options from the menus and drop-down lists that are displayed.

NOTE: 
• In Mac OS® X, click Save As on the Presets menu screen to save the current printer settings. You can 

create multiple presets and save each with its own distinctive name and printer settings. To print jobs 
using specific printer settings, click the applicable saved preset in the Presets list.

4 Click Print to print the job.
Mac OS X Print Driver Printing Options:
The table shown below uses Mac OS X 10.6 TextEdit as an example.

Printing options for Mac OS X

Item Printing Options
• Copies
• Collated
• Pages
• Paper Size
• Orientation

Layout • Pages per Sheet
• Layout Direction
• Border
• Two-Sided

Color Matching • ColorSync
• Vendor Matching

Paper Handling • Pages to Print
• Page Order
• Destination Paper Size

Cover Page • Print Cover Page
• Cover Page Type
• Billing Info

Scheduler • Print Document
• Priority

Job Accounting • Account Mode

Image Settings • Brightness
• Contrast
• Chroma
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Printer Features • Basic
– Output Color
– Paper Type

• Detailed Settings 1
– Image Type
– Image Rotation (180deg)
– Skip Blank Pages
– Draft Mode
– Trapping
– Image Enhancement

• Detailed Settings 2
– Sharpness Adjustment
– Screen

• Color Balance (C/M/Y/K)
– Low Density
– Medium Density
– High Density

Summary

Item Printing Options
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Printing Custom Size Paper
This section explains how to print on custom size paper using the print driver.
Custom size paper can be loaded in the multipurpose feeder (MPF) and priority sheet inserter (PSI). 
The way to load custom size paper in the MPF is the same as the one to load standard size paper. 
The way to load custom size paper in the PSI is the same as the one to load standard size paper.

See also: 
• "Loading Print Media in the Multipurpose Feeder (MPF)" on page 125
• "Loading Print Media in the Priority Sheet Inserter (PSI)" on page 134

Defining Custom Paper Sizes
Before printing, set the custom size on the print driver.

NOTE: 
• When setting the paper size on the print driver, be sure to specify the same size as the actual print media 

used. Setting the wrong size for printing can cause printer failure. This is especially true if you configure a 
bigger size when using a narrow width paper.

• Using the Windows Print Driver
On the Windows print driver, set the custom size in the Custom Paper Size dialog box. This section 
explains the procedure using Windows XP as an example.
For Windows XP or later, an administrator’s password only allows users with administrator rights to 
change the settings. Users without the rights of administrator can only view the contents.

1 Click start → Printers and Faxes.

2 Right-click the icon for your printer, and then select Properties.

3 Select the Configuration tab.

4 Click Custom Paper Size.

5 Select the custom setup you want to define from Details.

6 Specify the length of the short edge and long edge under Settings for. You can specify the 
values either by entering them directly or using the up arrow and down arrow buttons. The length 
of the short edge cannot be longer than the long edge, even if it is within the specified range. The 
length of the long edge cannot be shorter than the short edge, even if it is within the specified 
range.

7 To assign a paper name, select the Name Paper Size check box, and then enter the name in 
Paper Name. Up to 14 characters can be used for the paper name.

8 If necessary, repeat steps 5 to 7 to define another custom size.

9 Click OK twice.

Printing on Custom Size Paper
Use the following procedures to print using either the Windows or Mac OS X print drivers.
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• Using the Windows Print Driver
This section explains the procedure using Windows XP WordPad as an example.

NOTE: 
• The way to display the printer Properties/Printing Preferences dialog box differs according to the application 

software. Refer to the manual of your respective application software.

1 From the File menu, select Print.

2 Select the printer as the printer to be used and click Preferences.

3 Select the Paper / Output tab.

4 Select the size of the original document from Paper Size.

5 Select the appropriate paper type from Paper Type.

6 Click the Layout tab.

7 From Fit to New Paper Size, select the custom size you defined. If you have selected the 
custom size from Paper Size in step 4, select Same as Paper Size.

8 Click OK.

9 Click Print in the Print dialog box to start printing.

• Using the Mac OS X Print Driver
This section explains the procedure using Mac OS X 10.6 TextEdit as an example.

1 From the File menu, select Page Setup.

2 Select the printer as the printer to be used from Format For.

3 From Paper Size, select Manage Custom Sizes.

4 In the Custom Paper Sizes window, click +.
A newly created setting "Untitled" is displayed in the list.

5 Double-click "Untitled" and enter a name for the setting.

6 Enter the size of the original document in the Width and Height boxes of Paper Size.

7 Specify Non-Printable Area if necessary.

8 Click OK.

9 Make sure that the newly created paper size is chosen in Paper Size, and then click OK.

10 From the File menu, select Print.

11 Click Print to start printing.
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Checking Status of Print Data
This section includes:

• "Checking Status (Windows Only)" on page 155
• "Checking Status in CentreWare Internet Services (Windows & Mac OS X)" on page 155

Checking Status (Windows Only)
You can check the printer status with SimpleMonitor. Double-click the SimpleMonitor printer icon on 
the taskbar at the bottom right of the screen. The Select Printer window appears, which displays the 
printer name, printer connection ports, and printer status. Check the column Status to know the 
current status of your printer. 
Status Settings button: Displays the Status Settings screen and allows you to modify the 
SimpleMonitor settings.
Click the name of the desired printer listed on the Select Printer window. The Status Monitor window 
appears. You can check the printer status and print job status.
For more information about SimpleMonitor, see Help. The following procedure uses Windows XP as 
an example:

1 Click start → All Programs.

2 Select Fuji Xerox.

3 Select SimpleMonitor for Asia-Pacific.

4 Select SimpleMonitor Help.

See also: 
• "SimpleMonitor (Windows Only)" on page 46

Checking Status in CentreWare Internet Services (Windows & Mac 
OS X)
You can check the status of the print job sent to the printer at the Jobs tab of CentreWare Internet 
Services.

See also: 
• "Printer Management Software" on page 41
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Printing a Report Page
You can print a variety of settings for your printer including Printer Settings, Panel Settings, Job 
History Report, Error History Report, and Demo Page. This section describes two methods of printing 
a report page.

Printing a Printer Settings Page
To verify detailed printer settings, print a Printer Settings page.

See also: 
• "Understanding the Printer Menus" on page 164

The Operator Panel

1 Press the  (Menu) button.

2 Select Information Pgs, and then press the  button.

3 Select Printer Settings, and then press the  button.
The Printer Settings page is printed.

The Printer Setting Utility
The following procedure uses Windows XP as an example.

1 Click start → All Programs → Fuji Xerox → Fuji Xerox Printer Software for Asia-Pacific → 
FX DocuPrint CP205/FX DocuPrint CP205 w → Printer Setting Utility.

NOTE: 
• The Select Printer window appears in this step, when multiple print drivers are installed on your 

computer. In this case, click the name of the desired printer listed in Printer Name.
The Printer Setting Utility appears.

2 Click the Printer Settings Report tab.

3 Select Information Pages from the list at the left side of the page.
The Information Pages page is displayed.

4 Click Printer Settings.
The Printer Settings page is printed.
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Printer Settings
This section includes:

• "Using the Operator Panel to Change the Printer Settings" on page 157
• "Using the Printer Setting Utility to Change the Printer Settings" on page 158

Using the Operator Panel to Change the Printer Settings
You can select menu items and corresponding values from the operator panel.
When you first enter the menus from the operator panel, you see an asterisk (*) next to a value in the 
menus. This asterisk indicates the factory default menu setting. These settings are the original printer 
settings.

NOTE: 
• Factory defaults may vary for different countries.

When you select a new setting from the operator panel, an asterisk appears next to the setting to 
identify it as the current user default menu setting.
These settings are active until new ones are selected or the factory defaults are restored.
To select a new value as a setting:

1 Press the  (Menu) button.

2 Select Admin Menu, and then press the  button.

3 Select the desired menu, and then press the  button.

4 Select the desired menu or menu item, and then press the  button.
• If the selection is a menu, the menu is opened and the first menu item in the menu appears.
• If the selection is a menu item, the default menu setting for the menu item appears.
Each menu item has a list of values for the menu item. A value can be:

• A phrase or word to describe a setting
• A numerical value that can be changed
• An On or Off setting

NOTE: 
• Press the  and  button at the same time. This will display the factory default menu settings.

5 Select the desired value.

6 Press the  button.
This enables the setting value, which is indicated by an asterisk (*) next to the setting value.

7 Press the  (Back) or  button to return to the previous menu.
To continue setting other items, select the desired menu. To quit setting new values, press the  
(Menu) button to return to the main screen.

Driver settings may have precedence over changes previously made. In such case, change the 
defaults of the operator panel.
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Using the Printer Setting Utility to Change the Printer Settings
You can select menu items and corresponding values from the Printer Setting Utility.
The following procedure uses Windows XP as an example.

NOTE: 
• Factory defaults may vary for different countries.

These settings are active until new ones are selected or the factory defaults are restored.

To select a new value as a setting:

1 Click start → All Programs → Fuji Xerox → Fuji Xerox Printer Software for Asia-Pacific → 
FX DocuPrint CP205/FX DocuPrint CP205 w → Printer Setting Utility.

NOTE: 
• The Select Printer window appears in this step, when multiple print drivers are installed on your 

computer. In this case, click the name of the desired printer listed in Printer Name.
The Printer Setting Utility appears.

2 Click the Printer Maintenance tab.

3 Select the desired menu item.
Each menu item has a list of values for the menu item. A value can be:

• A phrase or word to describe a setting
• A numerical value that can be changed
• An On or Off setting

4 Select the desired value, and then click the associated button with each menu item.
Driver settings may have precedence over changes previously made and may require you to 
change the Printer Setting Utility defaults.
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Printing with Web Services on Devices (WSD)
This section provides information for network printing with WSD, the new Windows Vista, Windows 
Server 2008, Windows Server 2008 R2, and Windows 7 protocol of Microsoft.
This section includes:

• "Adding Roles of Print Services" on page 160
• "Printer Setup" on page 161
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Adding Roles of Print Services
When you use Windows Server 2008 or Windows Server 2008 R2, you need to add the roles of print 
services to the Windows Server 2008 or Windows Server 2008 R2 client.

• For Windows Server 2008:

1 Click Start → Administrative Tools → Server Manager.

2 From the Action menu, select Add Roles.

3 Select the Print Services check box on the Server Roles window in the Add Roles Wizard, and 
then click Next.

4 Click Next.

5 Select the Print Server check box, and then click Next.

6 Click Install.

• For Windows Server 2008 R2:

1 Click Start → Administrative Tools → Server Manager.

2 From the Action menu, select Add Roles.

3 Select the Print and Document Services check box on the Server Roles window in the Add 
Roles Wizard, and then click Next.

4 Click Next.

5 Select the Print Server check box, and then click Next.

6 Click Install.
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Printer Setup
You can install your new printer on the network using the Software Pack CD-ROM that shipped with 
your printer, or using Add Printer Wizard.

Installing a Print Driver Using the Add Printer Wizard

1 Click Start → Control Panel → Hardware and Sound → Printers (Start → Devices and 
Printers for Windows Server 2008 R2 and Windows 7).

2 Click Add a printer to launch the Add Printer Wizard.

3 Select Add a network, wireless or Bluetooth printer.

4 In the list of available printers, select the one you want to use, and then click Next.

NOTE: 
• In the list of available printers, the WSD printer is displayed in the form of http://IP address/ws/. 
• If no WSD printer is displayed in the list, enter the printer's IP address manually to create a WSD printer. 

To enter the printer's IP address manually, follow the instructions below. For Windows Server 2008 R2, to 
create a WSD printer, you must be a member of Administrators group.
1 Click The printer that I want isn't listed.
2 Select Add a printer using a TCP/IP address or hostname and click Next.
3 Select Web Services Device from Device type.
4 Enter the printer's IP address in the Hostname or IP address text box and click Next.

• Before installing the driver using the Add Printer wizard on Windows Server 2008 R2 or Windows 7, 
perform one of the followings:
- Establish the Internet connection so that Windows Update can scan your computer.
- Add the print driver to your computer in advance.

5 If prompted, install the print driver on your computer. If you are prompted for an administrator 
password or confirmation, type the password or provide confirmation.

6 Complete the additional steps in the wizard, and then click Finish.

7 Print a test page to verify print installation.
a Click Start → Control Panel → Hardware and Sound → Printers (Start → Devices and 

Printers for Windows Server 2008 R2 and Windows 7).
b Right-click the printer you just created, and then click Properties (Printer properties for 

Windows Server 2008 R2 and Windows 7).
c On the General tab, click Print Test Page. When a test page is printed successfully, 

installation is complete.
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6
Using the Operator Panel Menus

This chapter includes:
• "Understanding the Printer Menus" on page 164
• "Panel Lock Function" on page 179
• "Setting the PowerSaver Time Option" on page 182
• "Resetting to Factory Defaults" on page 183
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Understanding the Printer Menus
When your printer is configured as a network printer available to a number of users, the access to the 
operator panel menus can be limited. This prevents unauthorized users from using the operator panel 
to inadvertently change the default menu settings that has been set by the administrator. However, 
you can use settings for individual print jobs using the print driver. Print settings selected from the print 
driver have precedence over the default menu settings selected from the operator panel.
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Information Pgs
Use the Information Pgs menu to print the settings and history information of your printer.

NOTE: 
• A password is required to enter the operator panel menus when Panel Lock Set is set to Enable. In this 

case, enter the password you specified, and press the  button.

Printer Settings
Purpose:
To print a list of the information such as the printer name, the status of the printer, and the network 
settings.

Panel Settings
Purpose:
To print a detailed list of all the settings on the operator panel menus.

Job History
Purpose:
To print a detailed list of the print jobs that have been processed. This list contains the last 10 jobs.

Error History
Purpose:
To print a detailed list of paper jams and fatal errors.

Demo Page
Purpose:
To print a test page.
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Billing Meters
Use Billing Meters to check the total number of printed pages.

NOTE: 
• A password is required to enter the operator panel menus when Panel Lock Set is set to Enable. In this 

case, enter the password you specified, and press the  button.

Values:

Meter 1 Displays the total number of color prints.

Meter 2 Displays the total number of monochrome prints.

Meter 3 Displays the total number of large size color prints. 

Meter 4 Displays the total number of color and monochrome prints (Meter 1 + 
Meter 2).
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Admin Menu
Use the Admin Menu menu to configure a variety of printer features.

NOTE: 
• A password is required to enter the operator panel menus when Panel Lock Set is set to Enable. In this 

case, enter the password you specified, and press the  button.

Network Setup
Use the Network Setup menu to change the printer settings affecting jobs sent to the printer 
through the wired or wireless network.

NOTE: 
• Values marked by an asterisk (*) are the factory default menu settings.

• Ethernet
Purpose:
To specify the communication speed and the duplex settings of Ethernet. The change becomes 
effective after the printer is turned off and then on.
Values:

NOTE: 
• This item is displayed only when the printer is connected with a wired network.

• Wireless Status (DocuPrint CP205 w Only)
Purpose:
To display the information on the wireless signal strength. No changes can be made on the operator 
panel to improve the status of the wireless connection.
Values:

NOTE: 
• This item is displayed only when the printer is connected with a wireless network.

Auto* Detects the Ethernet settings automatically.

10Base Half Uses 10base-T half-duplex.

10Base Full Uses 10base-T full-duplex.

100Base Half Uses 100base-TX half-duplex.

100Base Full Uses 100base-TX full-duplex.

Good Indicates good signal strength.

Acceptable Indicates marginal signal strength.

Low Indicates insufficient signal strength.

No Reception Indicates that no signal is received.
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• Wireless Setup (DocuPrint CP205 w Only)
Purpose:
To configure the wireless network interface.
Values:

Manual Setup Enter (SSID) Specify a name to identify the wireless network. Up to 32 
alphanumeric characters can be entered.

Infrastructure Select when you configure the wireless setting through the access 
point such as a wireless router.

No Security Specify No Security to configure the wireless 
setting without specifying a security method from 
WEP, WPA-PSK-TKIP, and WPA2-PSK-AES.

WEP(64Bit) Specify the WEP 64bit Key to use through the 
wireless network. Enter 10 hexadecimal characters.

Transmit Key Specify the transmit key from 
WEP Key 1, WEP Key 2, WEP 
Key 3, and WEP Key 4.

WEP(128Bit) Specify the WEP 128bit Key to use through the 
wireless network. Enter 26 hexadecimal characters.

Transmit Key Specify the transmit key from 
WEP Key 1, WEP Key 2, WEP 
Key 3, and WEP Key 4.

WPA-PSK-
TKIP

Select to configure the wireless setting with the 
security method of WPA-PSK-TKIP.

PassPhraseEn
try

Specify the pass phrase of 
alphanumeric characters from 8 
to 63 only when WPA-PSK-TKIP 
is selected for Encryption Type.

WPA2-PSK-
AES

Select to configure the wireless setting with the 
security method of WPA2-PSK-AES.

PassPhraseEn
try

Specify the pass phrase of 
alphanumeric characters from 8 
to 63 only when WPA2-PSK-AES 
is selected for Encryption Type.

Ad-hoc Select to configure the wireless setting without the access point such 
as a wireless router.

No Security Specify No Security to configure the wireless 
setting without specifying the security method from 
WEP.

WEP(64Bit) Specify the WEP 64bit Key to use through the 
wireless network. Enter 10 hexadecimal characters.

Transmit Key Specify the transmit key from 
WEP Key 1, WEP Key 2, WEP 
Key 3, and WEP Key 4.

WEP(128Bit) Specify the WEP 128bit Key to use through the 
wireless network. Enter 26 hexadecimal characters.

Transmit Key Specify the transmit key from 
WEP Key 1, WEP Key 2, WEP 
Key 3, and WEP Key 4.
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NOTE: 
• This item is displayed only when the printer is connected with a wireless network.

• Init Wireless (DocuPrint CP205 w Only)
Purpose:
To initialize wireless network settings. After executing this function and rebooting the printer, all 
wireless network settings are reset to their factory default values.

NOTE: 
• This item is displayed only when the printer is connected with a wireless network.

• TCP/IP
Purpose:
To configure TCP/IP settings. The change becomes effective after the printer is turned off and then on.
Values:

• Protocol
Purpose:
To enable or disable each protocol. The change becomes effective after the printer is turned off and 
then on.
Values:

WPS Push Btn. Ctrl Configures the wireless setting with the security method of WPS-
PBC.

PIN Code Start Config. Configures the wireless setting using the PIN code 
assigned automatically by the printer.

Print PIN Code Prints the PIN code. Confirm it when you enter the 
PIN code to your computer.

IP Mode Dual Stack* Uses both IPv4 and IPv6 to set the IP address.

IPv4 Mode Uses IPv4 to set the IP address.

IPv6 Mode Uses IPv6 to set the IP address.

IPv4 Get IP 
Address

DHCP/AutoIP* Automatically sets the IP address.

BOOTP Uses BOOTP to set the IP address.

RARP Uses RARP to set the IP address.

DHCP Uses DHCP to set the IP address.

Panel Enables the IP address entered on the operator 
panel.

IP Address Manually sets the IP address allocated to the 
printer.

Network Mask Manually sets the subnet mask.

Gateway Address Manually sets the gateway address.

LPR Disable Disables the Line Printer Daemon (LPR) port.

Enable* Enables the LPR port.
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• Host Access List
Purpose:
To control the access from the specified IP addresses. The change becomes effective after the printer 
is turned off and then on.
Values:

• Reset Defaults
Purpose:
To initialize wired network data stored in Non-Volatile Memory (NVM). After executing this function and 
rebooting the printer, all wired network settings are reset to their default values.

• Wireless LAN (DocuPrint CP205 w Only)
Purpose:
To enable the wireless connection.
Values:

Port9100 Disable Disables the Port9100 port.

Enable* Enables the Port9100 port.

WSD Disable Disables the WSD port.

Enable* Enables the WSD port.

SNMP Disable Disables the Simple Network Management Protocol (SNMP) 
UDP port.

Enable* Enables the SNMP UDP port.

Email Alerts Disable Disables the Email Alerts feature.

Enable* Enables the Email Alerts feature.

InternetServices Disable Disables an access to CentreWare Internet Services 
embedded in the printer.

Enable* Enables an access to CentreWare Internet Services 
embedded in the printer.

Bonjour (mDNS) Disable Disables the Bonjour (mDNS).

Enable* Enables the Bonjour (mDNS).

No.1-5/Address Specifies the IP address which you want to control the access to your printer.

No.1-5/Mask Sets the subnet mask for the specified IP address.

No.1-5/Mode OFF* Selects whether to accept or reject the access from the 
specified IP address.Accept

Reject

Enable* Enables the wireless connection.

Disable Disables the wireless connection.
Using the Operator Panel Menus 170



USB Setup
Use the USB Setup menu to change printer settings affecting a USB port.

NOTE: 
• Values marked by an asterisk (*) are the factory default menu settings.

• Port Status
Purpose:
To change the USB settings on your printer. The change becomes effective after the printer is turned 
off and then on.
Values:

System Setup
Use the System Setup menu to configure the power saving mode, time-out time, job log auto print, 
mm/inch setting, default paper size setting, and low toner alert setting.

NOTE: 
• Values marked by an asterisk (*) are the factory default menu settings.

• PowerSaver Time
Purpose:
To specify the time for transition to Power Saver Mode.
Values:

Enter 5 in Mode 1 to put the printer in Mode1 five minutes after it finishes a job. This uses less energy, 
but requires more warm-up time for the printer. Enter 5 if your printer shares an electrical circuit with 
room lighting and you notice lights flickering.
Select a high value if your printer is in constant use. In most circumstances, this keeps the printer 
ready to operate with minimum warm-up time. Select a value between 5 and 30 minutes for Mode1 if 
you want a balance between energy consumption and a shorter warm-up period.
The printer automatically returns to the standby mode from the Power Saver Mode when it receives 
data from the computer. In Mode1, you can also return the printer to the standby mode by pressing 
any button on the operator panel. In Mode2, you can return the printer to the standby mode by 
pressing the  (Energy Saver) button.

Disable Disables the USB interface.

Enable* Enables the USB interface.

Mode1 5min.* Specifies the time taken by the printer before it enters Mode1 
after it finishes a job.5–30min.

Mode2 6min.* Specifies the time taken by the printer before it enters Mode2 
after it goes into Mode1.1–6min.
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• Fault Time-Out
Purpose:
To specify the time taken by the printer before it cancels jobs that stop abnormally. The print job is 
cancelled if it times out.
Values:

• Time-Out
Purpose:
To specify the amount of time that the printer waits for data to arrive from the computer. The print job is 
cancelled if it times out. 
Values:

• Auto Log Print
Purpose:
To automatically print a job history report after every 10 jobs.
Values:

NOTE: 
• The Job History report can also be printed using the Information Pgs menu.

• mm/ inch
Purpose:
To specify the measurement unit displayed after the numeric value on the operator panel.
Values:

Off Disables the fault time-out.

On 60sec.* Specifies the time taken by the printer before it cancels for jobs 
that stop abnormally.3–300sec.

Off Disables the job time-out.

On 30sec.* Specifies the amount of time that the printer waits for data to 
arrive from the computer.5–300sec.

Off* Does not automatically print a job history report.

On Automatically prints a job history report.

millimeter (mm)* Specifies the default measurement unit.

inch (")
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• Def. Paper Size
Purpose:
To specify the default paper size.
Values:

• Low Toner Msg
Purpose:
To specify whether to show the alert message when the toner is low.
Values:

Maintenance Mode
Use the Maintenance Mode menu to initialize Non-Volatile Memory (NVM), configure the plain 
paper quality adjustment settings, and configure the security settings.

NOTE: 
• Values marked by an asterisk (*) are the factory default menu settings.

• F/W Version
Purpose:
To display the version of the controller.

• Adjust PaperType
Purpose:
To adjust the paper type.
Values:

A4 - 210x297*
Letter - 8.5x11

Off Does not show the alert message when the toner is low.

On* Shows the alert message when the toner is low.

Plain Light
Normal*

Labels Light
Normal*
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• Adjust BTR
Purpose:
To specify the optimum voltage settings for printing for the transfer roller (BTR). To lower the voltage, 
set negative values. To increase, set positive values.
The default settings may not give the best output on all paper types. If you see mottles on the print 
output, try to increase the voltage. If you see white spots on the print output, try to decrease the 
voltage.

NOTE: 
• The print quality changes depending on the values you select for this item.

Values:

• Adj. Fusing Unit
Purpose:
To specify the optimum temperature settings for printing for the fusing unit. To lower the temperature, 
set negative values. To increase, set positive values.
The default settings may not give the best output on all paper types. When the printed paper has 
curled, try to lower the temperature. When the toner does not fuse on the paper properly, try to 
increase the temperature.

NOTE: 
• The print quality changes depending on the values you select for this item.

Values:

Plain 0*
-3 – +3

Bond 0*
-3 – +3

Light Card 0*
-3 – +3

Labels 0*
-3 – +3

JP Gloss Card 0*
-3 – +3

LW Gloss Card 0*
-3 – +3

Envelope 0*
-3 – +3

Recycled 0*
-3 – +3

Postcard 0*
-3 – +3

Plain 0*
-3 – +3
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• Auto Regi Adj
Purpose: 
To specify whether to automatically adjust color registration.
Values:

• Adjust ColorRegi
Purpose:
To specify whether to manually adjust color registration.
Color registration adjustments need to be made during the initial setup of the printer or when the 
printer is moved to a different location.
Values:

Bond 0*
-3 – +3

Light Card 0*
-3 – +3

Labels 0*
-3 – +3

JP Gloss Card 0*
-3 – +3

LW Gloss Card 0*
-3 – +3

Envelope 0*
-3 – +3

Recycled 0*
-3 – +3

Postcard 0*
-3 – +3

Off Does not automatically adjust color registration.

On* Automatically adjusts color registration.

Auto Adjust Automatically corrects color registration.

Color Regi Chart Prints a color registration chart. The color registration chart prints a lattice pattern of 
yellow, magenta, and cyan lines. On the chart, find the values on the right side that 
are next to the line that is perfectly straight for each of the three colors. If the value 
for this line is 0, color registration is not needed. If the value for this line is any value 
other than 0, specify the adjustment values under Enter Number.
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• Clear Developer
Purpose:
To rotate the developer motor and stir the toner in the toner cartridge.

• Toner Refresh
Purpose:
To use up a toner cartridge when you need to replace it before the end of its life, or to stir the toner in 
a new toner cartridge.
Values:

• BTR Refresh
Purpose:
Specify whether to execute counter measures for curling/separating discharge of the paper.
Values:

• Chart
Purpose:
To print various charts that can be used for diagnosing your printer.
Values:

Enter Number Enter 
(Y,M,C)

0, 0, 0* Specifies lateral (perpendicular to paper feed direction) color 
adjustment values individually for Y (Yellow), M (Magenta) 
and C (Cyan).

-5 – +5

Enter 
(LY,LM,L
C)

0, 0, 0* Specifies process (paper feed direction) color adjustment 
values individually for LY (Left Yellow), LM (Left Magenta) 
and LC (Left Cyan).

-5 – +5

Enter 
(RY,RM,
RC)

0, 0, 0* Specifies process (paper feed direction) color adjustment 
values individually for RY (Right Yellow), RM (Right 
Magenta) and RC (Right Cyan).

-5 – +5

Yellow Cleans the toner in the yellow toner cartridge.

Magenta Cleans the toner in the magenta toner cartridge.

Cyan Cleans the toner in the cyan toner cartridge.

Black Cleans the toner in the black toner cartridge.

Off* Does not automatically execute counter measures for 
curling/separating discharge of the paper.

On Automatically executes counter measures for curling/separating 
discharge of the paper.

Ghost Prints a chart to check for ghost printing.

4Colors Prints bands of yellow, magenta, cyan, and black with varying

density.

Alignment Prints a chart, and then check for proper alignment of the print

image on the paper.

Drum Refresh Prints a chart to check the light fatigue of the drum cartridge.
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• Initialize NVM
Purpose:
To initialize NVM for system parameters. After executing this function and rebooting the printer, all the 
menu parameters, except the parameters for the network, are reset to their factory default values.

See also: 
• "Resetting to Factory Defaults" on page 183

• Non-GenuineToner
Purpose:
To use toner cartridge of another manufacturer.

NOTE: 
• Using non-genuine toner cartridges may make some printer features unusable, reduce print quality and 

decrease the reliability of your printer. Fuji Xerox recommends only new Fuji Xerox brand toner cartridges for 
your printer. Fuji Xerox does not provide warranty coverage for problems caused by using accessories, parts, 
or components not supplied by Fuji Xerox.

• Before you use toner cartridge of another manufacturer, be sure to restart the printer.

Values

• Adjust Altitude
Purpose:
To specify the altitude of the location where the printer is installed. 
The discharge phenomenon for charging the photo conductor varies with barometric pressure. 
Adjustments are performed by specifying the altitude of the location where the printer is being used. 

NOTE: 
• An incorrect altitude adjustment setting leads to poor printing quality, incorrect indication of remaining toner. 

Values:

Secure Settings
Use the Secure Settings menu to set a password to limit access to the menus. This prevents 
items from being changed accidentally.

NOTE: 
• Values marked by an asterisk (*) are the factory default menu settings.

Off* Does not use toner cartridge of another manufacturer.

On Uses toner cartridge of another manufacturer.

0m* Specifies the altitude of the location where the printer is installed.

1000m
2000m
3000m
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• Panel Lock

Panel Lock Set
Purpose:
To restrict access to the operator panel menus.

See also: 
• "Panel Lock Function" on page 179

Values:

Change Password
Purpose:
To change a password to limit access to the operator panel menus.
Values:

NOTE: 
• This item is displayed only when Panel Lock Set is set to Enable.

• Login Error
Purpose:
To set the maximum number of failed login attempts before an administrator is denied access to the 
operator panel menus.
Values:

Disable* Does not restrict access to the operator panel menus.
Enable Restricts access to the operator panel menus with a password.

New 
Password

Sets a password required to access the operator panel menus.

Re-enter Enters the new password again to confirm.

Current 
Password

Enter the current password to change the password.

New Password Enter the new password.

Re-enter Enter the new password again to confirm.

Off* Does not set the maximum number of failed login attempts.

On 5times Sets the maximum number of failed login attempts.

1 - 10
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Panel Lock Function
This feature prevents unauthorized users from changing settings made by the administrator. However, 
you can select settings for individual print jobs using the print driver.
This section includes:

• "Enabling the Panel Lock" on page 180
• "Disabling the Panel Lock" on page 181
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Enabling the Panel Lock
1 Press the  (Menu) button.

2 Select Admin Menu, and then press the  button.

3 Select Secure Settings, and then press the  button.

4 Select Panel Lock, and then press the  button.

5 Select Panel Lock Set, and then press the  button.

6 Select Enable, and then press the  button.

7 Enter the new password, and then press the  button.

8 Re-enter the password to confirm the password that you entered, and then press the  button.

NOTE: 
• If you forget your password, turn off the printer. Then, while holding the  (Menu) button, turn on the printer. 

Continue to hold the  (Menu) button until the display indicates to enter the new password. Release the  
(Menu) button and enter the new password, and then press the  button. Re-enter the password to 
confirm, and then press the  button. The display will briefly indicate the password has been changed.

• If you change the password, perform steps 1. Enter the current password, and then press the  button. 
Perform steps 2 to 4. Select Change Password, and then press the  button. Enter the current password, 
and then press the  button. Perform steps 7 and 8. This will change the password.
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Disabling the Panel Lock
1 Press the  (Menu) button.

2 Enter the password, and then press the  button.

3 Select Admin Menu, and then press the  button.

4 Select Secure Settings, and then press the  button.

5 Select Panel Lock, and then press the  button.

6 Select Panel Lock Set, and then press the  button.

7 Select Disable, and then press the  button.

8 Enter the current password, and then press the  button.
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Setting the PowerSaver Time Option
You can set the power saver time for the printer. The printer switches to the Power Saver Mode after 
the specified time.

1 Press the  (Menu) button.

2 Select Admin Menu, and then press the  button.

3 Select System Setup, and then press the  button.

4 Select PowerSaver Time, and then press the  button.

5 Select Mode 1or Mode 2, and then press the  button.

6 Press the  or  button to select the desired value, and then press the  button.
You can select from 5–30 minutes for Mode 1 or 1–6 minutes for Mode 2.

7 To return to the previous screen, press the  (Back) button.
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Resetting to Factory Defaults
After executing Initialize NVM and rebooting the printer, all the menu parameters or data, except 
the parameters for the network are reset to their factory default values.

1 Press the  (Menu) button.

2 Select Admin Menu, and then press the  button.

3 Select Maintenance Mode, and then press the  button.

4 Select Initialize NVM, and then press the  button.

5 Ensure that Are you sure? appears, and then press the  button. The printer starts 
initializing the Non-Volatile Memory (NVM).

6 When the Initialized. message appears, turn off and then on the printer to apply the 
settings.
183 Using the Operator Panel Menus



Using the Operator Panel Menus 184



7
Troubleshooting

This chapter includes:
• "Clearing Jams" on page 186
• "Basic Printer Problems" on page 195
• "Display Problems" on page 196
• "Printing Problems" on page 197
• "Print Quality Problems" on page 199
• "Adjusting Color Registration" on page 216
• "Noise" on page 222
• "Other Problems" on page 223
• "Understanding Printer Messages" on page 224
• "Contacting Service" on page 228
• "Getting Help" on page 229
• "Non Genuine Toner Mode" on page 233
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Clearing Jams
This section includes:

• "Avoiding Jams" on page 187
• "Identifying the Location of Paper Jams" on page 188
• "Clearing Paper Jams From the Front of the Printer" on page 189
• "Clearing Paper Jams From the Back of the Printer" on page 190
• "Clearing Paper Jams From the Center Output Tray" on page 192
• "Jam Problems" on page 194

Careful selection of appropriate print media and proper loading allow you to avoid most jams. 

See also: 
• "About Print Media" on page 112
• "Supported Print Media" on page 116

NOTE: 
• Before buying large quantities of any print media, it is recommended that you try a sample first.
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Avoiding Jams
• Use only recommended print media.
• See "Loading Print Media in the Multipurpose Feeder (MPF)" on page 125 and "Loading Print 

Media in the Priority Sheet Inserter (PSI)" on page 134 to load print media properly.
• Do not overload the print media sources. Ensure that the stacked print media does not exceed 

the maximum height indicated on the paper width guides.
• Do not load wrinkled, creased, damp, or curled print media.
• Flex, fan, and straighten print media before you load it. If a jam occurs with print media, try 

feeding one sheet at a time through the MPF or the PSI.
• Do not use print media that you have cut or trimmed.
• Do not mix print media sizes, weights, or types in the same print media source.
• Ensure that the recommended print side is face up when you insert the print media.
• Keep print media stored in an acceptable environment.
• Do not remove the PSI during a print job.
• Ensure that all cables that connect to the printer are correctly attached.
• Overtightening the guides may cause jams.

See also: 
• "About Print Media" on page 112 
• "Supported Print Media" on page 116
• "Print Media Storage Guidelines" on page 115
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Identifying the Location of Paper Jams

IMPORTANT: 
• Do not attempt to clear any jams using tools or instruments. This may permanently damage the printer. 

The following illustration shows where paper jams may occur along the print media path.

CAUTION:
• Do not attempt to remove a paper jammed deeply inside the product, particularly a paper wrapped 

around a Fusing Unit or a heat roller. Otherwise, it may cause injuries or burns. Switch off the 
product promptly and contact your local Fuji Xerox representative.

1 Center Output Tray

2 Transfer Belt

3 Levers

4 Rear Door

5 Front Cover

6 Multipurpose feeder (MPF)

7 Priority Sheet Inserter (PSI)

1 2 3

4

56

7
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Clearing Paper Jams From the Front of the Printer
NOTE: 
• To resolve the error displayed on the LCD panel, you must clear all print media from the print media path.

1 Pull the PSI out.

2 Remove any paper jammed from the front of the printer.

3 Replace the PSI in the printer.

IMPORTANT: 
• Do not use excessive force on the PSI. Doing so could damage it or the inside of the printer.
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Clearing Paper Jams From the Back of the Printer
IMPORTANT: 
• To prevent electric shock, always turn off the printer and disconnect the power cord from the grounded outlet 

before performing maintenance.
• To avoid burns, do not clear paper jams immediately after printing. The fusing unit becomes extremely hot 

during use.

NOTE: 
• To resolve the error displayed on the LCD panel, you must clear all print media from the print media path.

1 Push the rear cover handle and open the rear door.

2 Lift up the levers.

3 Remove any paper jammed from the back of the printer.
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4 Lower the levers to their original position.

5 Close the rear door.
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Clearing Paper Jams From the Center Output Tray
IMPORTANT: 
• To prevent electric shock, always turn off the printer and disconnect the power cord from the grounded outlet 

before performing maintenance.
• To avoid burns, do not clear paper jams immediately after printing. The fusing unit becomes extremely hot 

during use.

NOTE: 
• To resolve the error displayed on the LCD panel, you must clear all print media from the print media path.

1 Push the rear cover handle and open the rear door.

2 Lift up the levers.

3 Remove any paper jammed from the back of the printer. If no paper is found in the paper path, 
then remove any paper jammed out of the center output tray.
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4 Lower the levers to their original position.

5 Close the rear door.
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Jam Problems
This section includes:

• "Misfeed jam" on page 194
• "Multi-feed jam" on page 194

Misfeed jam

NOTE: 
• If the problem continues even though you have taken suggested actions described above, contact the Fuji 

Xerox local representative office or an authorised dealer.

Multi-feed jam

NOTE: 
• If the problem continues even though you have taken suggested actions described above, contact the Fuji 

Xerox local representative office or an authorised dealer.

Problem Action
Print media misfeeds occur. Remove the paper from the PSI, and then ensure that the paper is 

properly inserted in the MPF.

Depending on the print media you use, take any of the following 
actions:
• For thick paper, use the one that is 216 gsm or less.
• For thin paper, use the one that is 60 gsm or more.
• For the envelope, ensure that it is properly loaded in the MPF or 

the PSI as instructed in "Loading Envelope in the Multipurpose 
Feeder (MPF)" on page 129 or "Loading Envelope in the Priority 
Sheet Inserter (PSI)" on page 136.

If the envelope is deformed, correct it or use another envelope.

If performing manual duplex printing, ensure that the print media is 
not curled.

Fan the print media.

If the print media is damp, turn over the print media.

If the problem continues, use print media that is not damp. 

Problem Action
Print media multiple feeds occur. Remove the paper from the PSI, and then ensure that the paper is 

inserted properly in the MPF.

If the print media is damp, use print media that is not damp.

Fan the print media. 
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Basic Printer Problems
Some printer problems can be easy to resolve. If a problem occurs with your printer, check each of the 
following:

• The power cord is connected to the printer, and to a properly grounded electrical outlet.
• The printer is turned on.
• The electrical outlet is not turned off at any switch or breaker.
• Other electrical equipment plugged into the outlet is working.
• When your printer is connected to the computer with the Wireless connection, the Ethernet cable 

is not connected between the printer and the network.
If you have checked all of the above and still have a problem, turn off the printer, wait for 10 seconds, 
and then turn on the printer. This often fixes the problem.
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Display Problems

Problem Action
After the printer is turned on, the 
display on the LCD panel is 
blank, keeps showing Please 
wait..., or the back light is not 
lit.

Turn off the printer, wait for 10 seconds, and turn on the printer. Self 
Test Message appears on the LCD panel. When the test is 
completed, Ready is displayed.

Menu settings changed from the 
operator panel have no effect.

Settings in the software program, the print driver, or the printer utilities 
have precedence over the settings made on the operator panel.

Change the menu settings from the print driver, the printer utilities, or 
the software program instead of the operator panel.
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Printing Problems

Problem Action
Job did not print or incorrect 
characters printed.

Ensure that Ready appears on the LCD panel before you send a job 
to print. Press the  (Menu) button to return to Ready.

Ensure that print media is loaded in the printer. Press the  (Menu) 
button to return to Ready.

Verify that you are using the correct print driver.

Ensure that you are using the correct Ethernet or USB cable and that 
it is securely connected to the printer.

Verify that the correct print media size is selected.

If you are using a print spooler, verify that the spooler has not stalled.

Check the interface of your printer from Admin Menu.

Determine the host interface you are using. Print a Printer Settings 
page to verify that the current interface settings are correct. Refer to 
"Printing a Printer Settings Page" on page 156 for details on how to 
print a Printer Settings page.

Print media misfeeds or multiple 
feeds occur.

Ensure that the print media you are using meets the specifications for 
your printer. 

See also: 
• "Usable Print Media" on page 117

Fan the print media before loading it.

Ensure that the print media is loaded correctly.

Ensure that the paper width guides and length guide are adjusted 
correctly.

Ensure that the PSI is securely inserted.

Do not overfill the print media sources.

Do not force print media into the PSI or the MPF when you load it.

Otherwise, it may skew or buckle.

Ensure that the print media is not curled.

Load the recommended print side correctly for the type of print media 
you are using.

See also: 
• "Loading Print Media" on page 122

Turn the print media over or around and try printing again to see if 
feeding improves.

Do not mix print media types.

Do not mix reams of print media.

Remove the top and bottom curled sheets of a ream before loading 
the print media.

Load a print media source only when it is empty.

The envelope is creased after 
printing.

Ensure that the envelope is loaded as instructed in "Loading 
Envelope in the Multipurpose Feeder (MPF)" on page 129 or 
"Loading Envelope in the Priority Sheet Inserter (PSI)" on page 136.
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Page breaks in unexpected 
places.

Increase the value for Job Time-Out in the System Settings menu, 
that is on the Printer Maintenance tab in the Printer Setting Utility.

Increase the time-out value in the Protocol Settings menu on 
CentreWare Internet Services.

Print media does not stack neatly 
in the center output tray.

Turn the print media stack over in the PSI and MPF.

Job prints from the wrong source 
or on the wrong print media.

Check Paper Type in the print driver.

Problem Action
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Print Quality Problems
This section includes:

• "The Output Is Too Light" on page 200
• "Toner Smears or Print Comes Off/Stain on Back Side" on page 201
• "Random Spots/Blurred Images" on page 202
• "The Entire Output Is Blank" on page 203
• "Streaks Appear on the Output" on page 204
• "Pitched Color Dots" on page 205
• "Vertical Blanks" on page 206
• "Mottle" on page 207
• "Ghosting" on page 208
• "Fog" on page 209
• "Bead-Carry-Out (BCO)" on page 210
• "Auger Mark" on page 211
• "Wrinkled/Stained Paper" on page 212
• "The Top Margin Is Incorrect" on page 213
• "Color Registration Is out of Alignment" on page 214
• "Protrudent/Bumpy Paper" on page 215

NOTE: 
• In this section, some procedures use the Printer Setting Utility or SimpleMonitor. Some procedures that use 

the Printer Setting Utility can also be performed using the operator panel.

See also: 
• "Understanding the Printer Menus" on page 164
• "Printer Setting Utility (Windows Only)" on page 45
• "SimpleMonitor (Windows Only)" on page 46
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The Output Is Too Light

NOTE: 
• If the problem continues even though you have taken suggested actions described above, contact the Fuji 

Xerox local representative office or an authorised dealer.

Problem Action
The output is too light. The toner cartridges may be low or need to be replaced. Confirm the 

amount of toner in each toner cartridge. 
1 Check the toner level in the Status tab in the Status Monitor 

window.
2 Replace the toner cartridges as necessary.

Verify that the print media is dry and the correct print media is used.

If not, use the print media recommended for the printer.

See also: 
• "Usable Print Media" on page 117

Try changing the Paper Type setting in the print driver.
1 On the Paper / Output tab in Printing Preferences of the print 

driver, change the Paper Type setting.

Disable Draft Mode in the print driver.
1 On the Advanced Settings tab in Printing Preferences of the 

print driver, ensure that the Draft Mode check box is not selected.
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Toner Smears or Print Comes Off/Stain on Back Side

NOTE: 
• If the problem continues even though you have taken suggested actions described above, contact the Fuji 

Xerox local representative office or an authorised dealer.

Problem Action
Toner smears or print comes off.
The output has stain on the back 
side.

The print media surface may be uneven. Try changing the Paper 
Type setting in the print driver. For example, change Plain to 
Lightweight Cardstock.
1 On the Paper / Output tab in Printing Preferences of the print 

driver, change the Paper Type setting.

Verify that the correct print media is being used.

If not, use the print media recommended for the printer.

See also: 
• "Usable Print Media" on page 117

Adjust the temperature of the fusing unit.
1 Launch the Printer Setting Utility, and click Adjust Fusing Unit on 

the Printer Maintenance tab.
2 Adjust the fixing temperature by turning up the value for your 

printing media.
3 Click the Apply New Settings button.
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Random Spots/Blurred Images

NOTE: 
• If the problem continues even though you have taken suggested actions described above, contact the Fuji 

Xerox local representative office or an authorised dealer.

Problem Action
The printed result has random 
spots or is blurred.

Ensure that the toner cartridges are installed correctly. 

See also: 
• "Installing a Toner Cartridge" on page 246

If you use non-genuine brand toner cartridges, install genuine brand 
toner cartridges.

Clean up the fusing unit.
1 Load one sheet of paper on the MPF, and then print a solid image 

all over paper.
2 Load the printed sheet with the side to be printed on facing down, 

and then print a blank sheet of paper.
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The Entire Output Is Blank

If this trouble happens, contact the Fuji Xerox local representative office or an authorised dealer.
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Streaks Appear on the Output

If this trouble happens, contact the Fuji Xerox local representative office or an authorised dealer.
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Pitched Color Dots

If this trouble happens, contact the Fuji Xerox local representative office or an authorised dealer.
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Vertical Blanks

NOTE: 
• If the problem continues even though you have taken suggested actions described above, contact the Fuji 

Xerox local representative office or an authorised dealer.

Problem Action
The printed result has vertical 
blanks.

Clean inside the printer and perform test print.
1 Clean inside the printer by using the print head cleaning rod. 
2 Click Print Test Page in the Properties window of the print driver.

See also: 
• "Cleaning Inside the Printer" on page 239
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Mottle

NOTE: 
• If the problem continues even though you have taken suggested actions described above, contact the Fuji 

Xerox local representative office or an authorised dealer.

Problem Action
The printed result has mottled 
appearance.

Adjust the transfer bias.
1 Launch the Printer Setting Utility, click Adjust BTR on the Printer 

Maintenance tab.
2 Adjust the setting for the type of print media being used.
3 Click the Apply New Settings button.

If you use non-recommended print media, use the print media 
recommended for the printer.
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Ghosting

NOTE: 
• If the problem continues even though you have taken suggested actions described above, contact the Fuji 

Xerox local representative office or an authorised dealer.

Problem Action
The printed result has ghosting. Adjust the transfer bias.

1 Launch the Printer Setting Utility, and click Chart Print on the 
Diagnosis tab.

2 Click the Ghost Configuration Chart button.
The Ghost Configuration Chart is printed.

3 Click BTR Refresh Mode on the Printer Maintenance tab.
4 Select the check box next to On, and then click the Apply New 

Settings button.
5 Click Chart Print on the Diagnosis tab.
6 Click the Ghost Configuration Chart button.

The Ghost Configuration Chart is printed.

The print media surface may be uneven. Try changing the Paper 
Type setting in the print driver. For example, change Plain to 
Lightweight Cardstock.
1 On the Paper / Output tab in Printing Preferences of the print 

driver, change the Paper Type setting.

Adjust the temperature of the fusing unit.
1 Launch the Printer Setting Utility, and click Adjust Fusing Unit on 

the Printer Maintenance tab.
2 Adjust the fixing temperature by turning up the value for your 

printing media.
3 Click the Apply New Settings button.

If you use non-recommended print media, use the print media 
recommended for the printer.
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Fog

NOTE: 
• If the problem continues even though you have taken suggested actions described above, contact the Fuji 

Xerox local representative office or an authorised dealer.

Problem Action
The printed result is foggy. When the whole is printed light, contact the Fuji Xerox local 

representative office or an authorised dealer.

When the printed page is partly light, start Developer Stir Mode.
1 Launch the Printer Setting Utility, and click Developer Stir Mode 

on the Diagnosis tab.
2 Click the Start button.
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Bead-Carry-Out (BCO)

NOTE: 
• If the problem continues even though you have taken suggested actions described above, contact the Fuji 

Xerox local representative office or an authorised dealer.

Problem Action
Bead-Carry-Out (BCO) is 
happening.

If the printer is installed in a high altitude location, set the altitude of 
the location.
1 Launch the Printer Setting Utility, and click Adjust Altitude on the 

Printer Maintenance tab.
2 Select the value close to the altitude of the location where the 

printer is installed.
3 Click the Apply New Settings button.
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Auger Mark

NOTE: 
• If the problem continues even though you have taken suggested actions described above, contact the Fuji 

Xerox local representative office or an authorised dealer.

Problem Action
The printed result has auger 
mark.

The toner cartridges may be low or need to be replaced. Confirm the 
amount of toner in each toner cartridge.
1 Check the toner level in the Status tab in the Status Monitor 

window.
2 Replace the toner cartridges as necessary.

Start Developer Stir Mode.
1 Launch the Printer Setting Utility, and click Developer Stir Mode 

on the Diagnosis tab.
2 Click the Start button.
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Wrinkled/Stained Paper

NOTE: 
• If the problem continues even though you have taken suggested actions described above, contact the Fuji 

Xerox local representative office or an authorised dealer.

Problem Action
The output is wrinkled.
The output is stained.

Verify that the correct print media is being used.

If not, use the print media recommended for the printer.

See also: 
• "Usable Print Media" on page 117
• "About Print Media" on page 112

If you use the envelope, check whether the crease is within 30 mm of 
the four edges of the envelope.

If the crease is within 30 mm of the four edges of the envelope, this is 
considered normal. Your printer is not at fault.

If not, take the following actions:
• If the envelope is #10 envelope, which is 220 mm or longer and 

has a flap on the long edge, use a different size envelope.
• If the envelope is C5, which is 220 mm or longer and has a flap on 

the short edge, load it in the MPF with the flap open and facing up.
• If the envelope is Monarch or DL, which is shorter than 220 mm, 

load it long edge feed in the MPF with the flap open and facing up.
If the problem continues, use a different size envelope.
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The Top Margin Is Incorrect

NOTE: 
• If the problem continues even though you have taken suggested actions described above, contact the Fuji 

Xerox local representative office or an authorised dealer.

Problem Action
The top margin is incorrect. Ensure that the margins are set correctly on the application being 

used.
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Color Registration Is out of Alignment

NOTE: 
• If the problem continues even though you have taken suggested actions described above, contact the Fuji 

Xerox local representative office or an authorised dealer.

Problem Action
Color registration is out of 
alignment.

Execute auto color registration adjustment.
1 Launch the Printer Setting Utility, and click Color Registration 

Adjustment on the Printer Maintenance tab.
2 Deselect the check box next to On.
3 Click the Start button next to Auto Correct.

Clean the CTD sensor.
1 Clean the CTD sensor. 
2 Launch the Printer Setting Utility, and click Color Registration 

Adjustment on the Printer Maintenance tab.
3 Deselect the check box next to On.
4 Click the Start button next to Auto Correct.

See also: 
• "Cleaning the Color Toner Density (CTD) Sensor" on page 242

Print the color registration chart and manually correct the color 
registration. 
1 Launch the Printer Setting Utility, and click Color Registration 

Adjustment on the Printer Maintenance tab.
2 Deselect the check box next to On.
3 Click the Start button next to Print Color Regi Chart.
4 Select the paper size, and then click OK.

The color registration chart is printed.
5 Check the values with the straight lines on the chart.
6 Select the value for each color on the Printer Setting Utility.
7 Click the Apply New Settings button.
8 Click the Start button next to Print Color Regi Chart to print the 

color registration chart again.
9 Adjust till all straight lines are at the value of 0.

See also: 
• "Adjusting Color Registration" on page 216
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Protrudent/Bumpy Paper

NOTE: 
• If the problem continues even though you have taken suggested actions described above, contact the Fuji 

Xerox local representative office or an authorised dealer.

Problem Action
Printed surface got 
protrudent/bumpy.

Clean up the fusing unit.
1 Load one sheet of paper on the MPF, and then print a solid image 

all over paper.
2 Load the printed sheet with the side to be printed on facing down, 

and then print a blank sheet of paper.
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Adjusting Color Registration
This section describes how to adjust the color registration when you first install the printer or after 
moving it to a new location.
This section includes:

• "Performing Auto Correct" on page 217
• "Printing the Color Registration Chart" on page 218
• "Determining Values" on page 219
• "Entering Values" on page 220
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Performing Auto Correct
Auto Correct allows you to correct the color registration automatically.

The Operator Panel

1 Press the  (Menu) button.

2 Select Admin Menu, and then press the  button.

3 Select Maintenance Mode, and then press the  button.

4 Select Adjust ColorRegi, and then press the  button.

5 Select Auto Adjust, and then press the  button.

6 Select Are you sure?, and then press the  button.
Auto Correct is performed.

The Printer Setting Utility
The following procedure uses Microsoft® Windows® XP as an example. 

1 Click start → All Programs → Fuji Xerox → Fuji Xerox Printer Software for Asia-Pacific → 
FX DocuPrint CP205/FX DocuPrint CP205 w → Printer Setting Utility.

NOTE: 
• The Select Printer window appears in this step, when multiple print drivers are installed on your 

computer. In this case, click the name of the desired printer listed in Printer Name.
The Printer Setting Utility opens.

2 Click the Printer Maintenance tab.

3 Select Color Registration Adjustment from the list at the left side of the page.
The Color Registration Adjustment page is displayed.

4 Deselect the check box next to On.

5 Click the Start button next to Auto Correct.
The color registration is corrected automatically.
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Printing the Color Registration Chart

The Operator Panel

1 Press the  (Menu) button.

2 Select Admin Menu, and then press the  button.

3 Select Maintenance Mode, and then press the  button.

4 Select Adjust ColorRegi, and then press the  button.

5 Select Color Regi Chart, and then press the  button.
The color registration chart is printed.

The Printer Setting Utility
The following procedure uses Windows XP as an example. 

1 Click start → All Programs → Fuji Xerox → Fuji Xerox Printer Software for Asia-Pacific → 
FX DocuPrint CP205/FX DocuPrint CP205 w → Printer Setting Utility.

NOTE: 
• The Select Printer window appears in this step, when multiple print drivers are installed on your 

computer. In this case, click the name of the desired printer listed in Printer Name.
The Printer Setting Utility opens.

2 Click the Printer Maintenance tab.

3 Select Color Registration Adjustment from the list at the left side of the page.
The Color Registration Adjustment page is displayed.

4 Deselect the check box next to On.

5 Click the Start button next to Print Color Regi Chart.

6 Select the paper size, and then click OK.
The color registration chart is printed.
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Determining Values
On the color registration chart printed, find the straightest lines where the two black lines and the 
colored line are most closely aligned for each color (Y, M, and C).
If you find the straightest line, make a note of the value (-5 – +5) indicated by the straightest line for 
each color.
When the value is 0 for each color, you do not need to adjust the color registration.
When the value is not 0, enter the value according to the procedure in "Entering Values" on page 220.
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Entering Values

The Operator Panel
Using the operator panel, enter the values that you found in the color registration chart to make 
adjustments. 

1 Press the  (Menu) button.

2 Select Admin Menu, and then press the  button.

3 Select Maintenance Mode, and then press the  button.

4 Select Adjust ColorRegi, and then press the  button.

5 Select Enter Number, and then press the  button.

6 Ensure that Enter (Y,M,C) appears, and then press the  or  button until you reach the 
value (for example, +3) displayed on the chart.

7 Press the  button once and move the cursor to the next color.

8 Repeat steps 6 and 7 to enter all of the digits, and then press the  button.

9 Ensure that Enter (LY,LM,LC) appears.

10 Press the  or  button until you reach the value (for example, +3) displayed on the chart.

11 Press the  button once and move the cursor to the next color.

12 Repeat steps 10 and 11 to enter all of the digits, and then press the  button.

13 Ensure that Enter (RY,RM,RC) appears.

14 Press the  or  button until you reach the value (for example, +3) displayed on the chart.

15 Press the  button once and move the cursor to the next color.

16 Repeat steps 14 and 15 to enter all of the digits, and then press the  button.
The top screen appears.

17 Perform steps 1 to 4 to enter the Adjust ColorRegi menu.

18 Select Color Regi Chart, and then press the  button.
The color registration chart is printed with the new values.

19 Adjust till all straight lines are at the value of 0. Viewing the images before and after will help.
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The Printer Setting Utility
Using the Printer Setting Utility, enter the values that you found in the color registration chart to make 
adjustments. 
The following procedure uses Windows XP as an example. 

1 Click start → All Programs → Fuji Xerox → Fuji Xerox Printer Software for Asia-Pacific → 
FX DocuPrint CP205/FX DocuPrint CP205 w → Printer Setting Utility.

NOTE: 
• The Select Printer window appears in this step, when multiple print drivers are installed on your 

computer. In this case, click the name of the desired printer listed in Printer Name.
The Printer Setting Utility opens.

2 Click the Printer Maintenance tab.

3 Select Color Registration Adjustment from the list at the left side of the page.
The Color Registration Adjustment page is displayed.

4 Deselect the check box next to On.

5 Select the value you checked in the color registration chart, and then click the Apply New 
Settings button.

6 Click the Start button next to Print Color Regi Chart.

7 Select the paper size, and then click OK.
The color registration chart is printed with the new values.

8 Adjust until all straight lines are at the value of 0. Show image of before and after adjustment will 
help.

IMPORTANT: 
• After printing the color registration chart, do not turn off the printer until the printer motor has stopped running. 
• If 0 is not next to the straightest lines, determine the values and adjust the printer again. 
221 Troubleshooting



Noise
NOTE: 
• In this section, the procedures use the Printer Setting Utility. 

See also: 
• "Printer Setting Utility (Windows Only)" on page 45

Problem Action
The printer makes a strange 
noise.

Locate the cause of the problem by removing the toner cartridges.
1 Remove the toner cartridges. 
2 Launch the Printer Setting Utility, and click Machine Check on the 

Diagnosis tab.
3 Select Main Motor Operation Check from the drop-down list box, 

and click the Start button.
4 Click the Play of Sound button to check the motor sound.

See also: 
• "Replacing Toner Cartridges" on page 243

If the noise generated from the printer matches with the noise from 
the Play of Sound button, contact the Fuji Xerox local representative 
office or an authorised dealer.

Perform Dispense Motor Check.
1 Ensure that the toner cartridges are removed. 
2 Launch the Printer Setting Utility, and click Machine Check on the 

Diagnosis tab.
3 Select Dispense Motor Check(Yellow), Dispense Motor 

Check(Magenta), Dispense Motor Check(Cyan), or Dispense 
Motor Check(Black) from the drop-down list box, and click the 
Start button.

4 Click the Play of Sound button to check the motor sound.
5 Repeat steps 3 and 4 to perform Dispense Motor Check for the rest 

of the toner cartridges.

NOTE: 
• You can perform Dispense Motor Check for CMYK in any order 

you desire.
• Do not check the operation of the dispense motor repeatedly.

If the noise generated from the printer matches with the noise from 
the Play of Sound button, contact the Fuji Xerox local representative 
office or an authorised dealer.

Reinstall the toner cartridges and perform Dispense Motor Check.

If the noise generated from the printer matches with the noise from 
the Play of Sound button, contact the Fuji Xerox local representative 
office or an authorised dealer.
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Other Problems

Problem Action
Condensation has occurred 
inside the printer.

This usually occurs within several hours after you heat the room in 
winter. This also occurs when the printer is operating in a location 
where relative humidity reaches 85% or more. Adjust the humidity or 
relocate the printer to an appropriate environment.
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Understanding Printer Messages
The printer LCD panel displays messages describing the current state of the printer and indicates 
possible printer problems you must resolve. This section describes messages, their meanings, and 
how to clear the messages.

IMPORTANT: 
• When an error code is displayed, the print data remaining on the printer and the information accumulated in 

the memory of the printer are not secured.

Error-Code What You Can Do
010-397 Turn off the printer, and then on. If this does not solve the problem, contact the Fuji 

Xerox local representative office or an authorised dealer.

See also: 
• "Online Services" on page 267

016-500 Turn off the printer, and then on. If this does not solve the problem, contact the Fuji 
Xerox local representative office or an authorised dealer.

See also: 
• "Online Services" on page 267

016-501

016-502

016-602 This is not an error. You can continue operation normally.

016-610 Turn off the printer, and then on. If this does not solve the problem, contact the Fuji 
Xerox local representative office or an authorised dealer.

See also: 
• "Online Services" on page 267

016-612

016-718 Press the  button to cancel the current print job.

See also: 
• "Canceling a Print Job" on page 147

016-720

016-737

016-741

016-742

016-743

016-744

016-745

016-799

016-920 Press the  button. Execute the operation again according to the operation procedure.

016-921

016-922 Press the  button. Set only wireless LAN access point (Registrar) to be operated with 
WPS-PBC, and execute the operation again according to the operation procedure.

018-318 Turn off the printer, and then on. If this does not solve the problem, contact the Fuji 
Xerox local representative office or an authorised dealer.

See also: 
• "Online Services" on page 267

024-340 Turn off the printer, and then on. If this does not solve the problem, contact the Fuji 
Xerox local representative office or an authorised dealer.

See also: 
• "Online Services" on page 267
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024-360 Turn off the printer, and then on. If this does not solve the problem, contact the Fuji 
Xerox local representative office or an authorised dealer.

See also: 
• "Online Services" on page 267

024-371 Turn off the printer, and then on. Or, unplug the Ethernet cable or USB cable, and then 
plug it again. If this does not solve the problem, contact the Fuji Xerox local 
representative office or an authorised dealer.

See also: 
• "Online Services" on page 267

024-958 Load the correct paper.

See also: 
• "Loading Print Media in the Multipurpose Feeder (MPF)" on page 125
• "Loading Print Media in the Priority Sheet Inserter (PSI)" on page 134

024-963

027-446 Change IP address to avoid duplication. Turn off the printer, and turn it on again.

027-452

041-340 Turn off the printer, and then on. If this does not solve the problem, contact the Fuji 
Xerox local representative office or an authorised dealer.

See also: 
• "Online Services" on page 267

042-325 Turn off the printer, and then on. If this does not solve the problem, contact the Fuji 
Xerox local representative office or an authorised dealer.

See also: 
• "Online Services" on page 267

042-358

042-372

061-370 Turn off the printer, and then on. If this does not solve the problem, contact the Fuji 
Xerox local representative office or an authorised dealer.

See also: 
• "Online Services" on page 267

075-100 Check and clear the paper path, load the specified paper, and then press the  button.

See also: 
• "Clearing Paper Jams From the Front of the Printer" on page 189

075-921 Load paper for the second side (odd) pages, and press the  button. 

See also: 
• "Manual Duplex Printing (Windows Print Driver Only)" on page 140

077-100 Check and clear the paper path.

See also: 
• "Clearing Paper Jams From the Back of the Printer" on page 190

077-104

077-106 Check and clear the paper path.

See also: 
• "Clearing Paper Jams From the Center Output Tray" on page 192

077-108

077-109

077-304 Close the rear door.

Error-Code What You Can Do
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077-900 Check and clear the paper path.

See also: 
• "Clearing Paper Jams From the Center Output Tray" on page 192

077-901 Check and clear the paper path.

See also: 
• "Clearing Paper Jams From the Back of the Printer" on page 190

091-402 Contact the Fuji Xerox local representative office or an authorised dealer.

See also: 
• "Online Services" on page 267

092-651 Turn off the printer, and then on. If this does not solve the problem, contact the Fuji 
Xerox local representative office or an authorised dealer.

See also: 
• "Online Services" on page 267

092-661

092-310 Clean the CTD sensor. 

See also: 
• "Cleaning the Color Toner Density (CTD) Sensor" on page 242

092-910

093-423 Replace the specified toner cartridge soon. 

See also: 
• "Replacing Toner Cartridges" on page 243

093-424

093-425

093-426

093-919 Re-install the specified toner cartridge. And, turn off the printer, and then on.

See also: 
• "Replacing Toner Cartridges" on page 243

093-920

093-921

093-922

093-930 Remove the specified toner cartridge and install a new one. If you do not replace the 
toner cartridge, print quality problems may occur. 

See also: 
• "Replacing Toner Cartridges" on page 243

093-931

093-932

093-933

093-950 Check the specified toner cartridge if there is any malfunction. Re-install the specified 
toner cartridge.

See also: 
• "Replacing Toner Cartridges" on page 243

093-951

093-952

093-925

093-960 Re-install the specified toner cartridge with the supported one. 

See also: 
• "Replacing Toner Cartridges" on page 243

093-961

093-962

093-926

093-970 Re-install the specified toner cartridge.

See also: 
• "Replacing Toner Cartridges" on page 243

093-971

093-972

093-973

Error-Code What You Can Do
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116-314 Turn off the printer, and then on. If this does not solve the problem, contact the Fuji 
Xerox local representative office or an authorised dealer.

See also: 
• "Online Services" on page 267

116-315

116-317

116-324

116-326

116-343

116-350

116-351

116-352

116-355

124-333 Turn off the printer, and then on. If this does not solve the problem, contact the Fuji 
Xerox local representative office or an authorised dealer.

See also: 
• "Online Services" on page 267

191-310

193-700 This message indicates the printer is in the Non GenuineToner mode.

Error-Code What You Can Do
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Contacting Service
When you call for printer service, be prepared to describe the problem you are experiencing or the 
error message on the LCD panel.
You need to know the model of your printer and serial number. See the label on the rear door of your 
printer.
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Getting Help
This section includes:

• "LCD Panel Messages" on page 230
• "SimpleMonitor Alerts" on page 231
• "Obtaining the Product Information" on page 232

Fuji Xerox provides several automatic diagnostic tools to help you produce and maintain print quality.
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LCD Panel Messages
The LCD panel provides you with information and troubleshooting help. When an error or warning 
condition occurs, the LCD panel displays a message informing you of the problem. 

See also: 
• "Understanding Printer Messages" on page 224
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SimpleMonitor Alerts
The SimpleMonitor is a tool that is included on the Software Pack CD-ROM. It automatically checks 
the printer status when you send a print job. If the printer is unable to print your job, the SimpleMonitor 
automatically displays an alert on your computer screen to let you know that the printer needs 
attention.
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Obtaining the Product Information

Obtaining the Latest Print Driver
The latest print driver can be obtained by downloading it from our web site.

NOTE: 
• The communication fee shall be borne by users. 

1 In your print driver's Printing Preferences dialog box, click the Advanced Settings tab and then 
click About.

2 Click Fuji Xerox Web Site. 
Your web browser launches and our web site is displayed.

3 Follow the instructions on the web site and download an appropriate print driver.

NOTE: 
• The URL of the driver download service page is as follows: http://www.fujixeroxprinters.com/
• For the latest information about the print driver features, refer to the online Help provided for the print driver.

Updating the Printer's Firmware
Our web site also provides a tool that allows you to update the printer's firmware (software embedded 
within the printer) from your computer.
The latest firmware and updating tool can be downloaded from the following URL.
Follow the instructions on the web site and download the correct firmware update.
http://www.fujixeroxprinters.com/

NOTE: 
• The communication fee shall be borne by users.
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Non Genuine Toner Mode
When toner within a toner cartridge is empty, the Replace XXXX Cartridge or Empty XXXX 
Cartridge (XXXX: Yellow, Magenta, Cyan, or Black) message appears.
When you want to use the printer in the Non Genuine Toner mode, enable the Non Genuine Toner 
mode and replace the toner cartridge.

IMPORTANT: 
• If you use the printer in the Non Genuine Toner mode, the performance of the printer may not be at its 

optimum. And any problems that may arise from the use of the Non Genuine Toner mode are not covered by 
our quality guarantee. The continuous use of the Non Genuine Toner mode can also cause the printer to 
break down, and any repair charges for such break down will be incurred by users.

NOTE: 
• To disable the Non Genuine Toner mode, select Off for Non-GenuineToner on the operator panel or 

deselect the check box next to On on the Non Genuine Toner page on the Printer Setting Utility.

This section includes:
• "The Operator Panel" on page 234
• "The Printer Setting Utility" on page 235
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The Operator Panel
NOTE: 
• Before starting the operation described below, confirm that Ready is displayed on the LCD panel.

1 Press the  (Menu) button.

2 Select Admin Menu and then press the  button.

3 Select Maintenance Mode and then press the  button. 

4 Select Non-GenuineToner and then press the  button. 

5 Select On and then press the  button. 

6 Press the  button until the top page is displayed.
The printer switches to the Non-GenuineToner mode.
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The Printer Setting Utility
The following procedure uses Windows XP as an example. 

1 Click start → All Programs → Fuji Xerox → Fuji Xerox Printer Software for Asia-Pacific → 
FX DocuPrint CP205/FX DocuPrint CP205 w → Printer Setting Utility.

NOTE: 
• The Select Printer window appears in this step, when multiple print drivers are installed on your 

computer. In this case, click the name of the desired printer listed in Printer Name.
The Printer Setting Utility opens.

2 Click the Printer Maintenance tab.

3 Select Non Genuine Toner from the list at the left side of the page.
The Non Genuine Toner page is displayed.

4 Select the check box next to On, and then click the Apply New Settings button.
235 Troubleshooting



Troubleshooting 236



8
Maintenance

This chapter includes:
• "Cleaning the Printer" on page 238
• "Replacing Toner Cartridges" on page 243
• "Ordering Supplies" on page 248
• "Storing Consumables" on page 252
• "Managing the Printer" on page 253
• "Conserving Supplies" on page 259
• "Checking Page Counts" on page 260
• "Moving the Printer" on page 261
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Cleaning the Printer
This section describes how to clean the printer in order to maintain it in good condition and print clean 
printouts all the time.

This section includes:
• "Cleaning Inside the Printer" on page 239
• "Cleaning the Color Toner Density (CTD) Sensor" on page 242

WARNING:
• When cleaning this product, use the designated cleaning materials exclusive to it. Other cleaning 

materials may result in poor performance of the product. Never use aerosol cleaners, or it may catch 
fire and cause explosion.

CAUTION:
• When cleaning this product, always switch off and unplug it. Access to a live machine interior may 

cause electric shock.
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Cleaning Inside the Printer
1 Turn off the printer.

2 Open the toner access cover.

3 Pinch the toner cartridge firmly as shown in the illustration.

4 Pull the toner cartridge out.

IMPORTANT: 
• Always pull the toner cartridge out slowly so you do not spill any toner. 

5 Pull the other three toner cartridges out as well.

6 Pull the print head cleaning rod out.
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7 Insert the print head cleaning rod fully into the hole beside the arrow on the printer until its tip 
reaches the interior of the printer as illustrated below, and then pull it out.

8 Repeat the same procedure for the other three holes.

9 Return the print head cleaning rod to its original location.

10 Replace the black toner cartridge by adjusting it to the associated cartridge holder, and then 
insert it firmly by pressing near the center of the label until the toner cartridge clicks.
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11 Replace the other three toner cartridges as well.

12 Close the toner access cover.
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Cleaning the Color Toner Density (CTD) Sensor
Clean the CTD sensor only when an alert for the CTD sensor is shown on the Status Monitor window 
or operator panel.

1 Ensure that the printer is turned off.

2 Push the rear cover handle and open the rear door.

3 Clean the CTD sensor inside the printer with a clean dry cotton swab.

4 Close the rear door.
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Replacing Toner Cartridges
Fuji Xerox toner cartridges are available only through Fuji Xerox.
It is recommended that you use Fuji Xerox toner cartridges for your printer. Fuji Xerox does not 
provide warranty coverage for problems caused by using accessories, parts, or components not 
supplied by Fuji Xerox.

IMPORTANT: 
• Do not shake the used toner cartridge to avoid spilling of the toner.
• Be sure to use the starter toner cartridge shipped with the printer until it gets empty, and then replace it with a 

purchased one.

This section includes:
• "Overview" on page 244
• "Removing the Toner Cartridges" on page 245
• "Installing a Toner Cartridge" on page 246

WARNING:
• Use a broom or a wet cloth to wipe off spilled toner. Never use a vacuum cleaner for the spills.

It may catch fire by electric sparks inside the vacuum cleaner and cause explosion. If you spill a large 
volume of toner, contact your local Fuji Xerox representative.

• Never throw a toner cartridge into an open flame. Remaining toner in the cartridge may catch fire and 
cause burn injuries or explosion.
If you have a used toner cartridge no longer needed, contact your local Fuji Xerox representative for 
its disposal.

CAUTION:
• Keep toner cartridges out of the reach of children. If a child accidentally swallows toner, spit it out, 

rinse mouth with water, drink water and consult a physician immediately.
• When replacing toner cartridges, be careful not to spill the toner. In case of any toner spills, avoid 

contact with clothes, skin, eyes and mouth as well as inhalation.
• If toner spills onto your skin or clothing, wash it off with soap and water. 

If you get toner particles in your eyes, wash it out with plenty of water for at least 15 minutes until 
irritation is gone. Consult a physician if necessary. 
If you inhale toner particles, move to a fresh air location and rinse your mouth with water.
If you swallow toner, spit it out, rinse your mouth with water, drink plenty of water and consult a 
physician immediately.
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Overview
The printer has toner cartridges of four colors: black (K), yellow (Y), magenta (M), and cyan (C).
When a toner cartridge reaches its usable life-span, the following messages appear on the LCD panel 
(XXXX: Yellow, Magenta, Cyan, or Black).

IMPORTANT: 
• When placing a used toner cartridge on the floor or on a table, place a few sheets of paper under the toner 

cartridge to catch any toner that may spill.
• Do not reuse old toner cartridges once you remove them from the printer. Doing so can impair print quality.
• Do not shake or pound the used toner cartridges. The remaining toner may spill.
• We recommend you to use up the toner cartridges within one year after removing them from the packaging.

Message Action
XXXX Low

Replace Soon*
The specified toner cartridge has become low. Prepare a new one.

Replace

XXXX Cartridge

The specified toner cartridge has become empty. Replace the old toner cartridge 
with a new one.

Empty

XXXX Cartridge

The specified toner cartridge has become empty. Replace the old toner cartridge 
with a new one.

* This warning appears only when Fuji Xerox toner cartridges are used (Non-GenuineToner is set to 
Off.)
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Removing the Toner Cartridges
1 Turn off the printer.

2 Open the toner access cover.

3 Spread a few sheets of paper on the floor or table where the removed toner cartridge is placed.

4 Pinch the toner cartridge firmly as shown in the illustration.

5 Pull the toner cartridge out.

IMPORTANT: 
• Always pull the toner cartridge out slowly so you do not spill any toner. 

6 Place the toner cartridge slowly on the sheets of paper spread in step 3.
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Installing a Toner Cartridge
1 Unpack a new toner cartridge of the desired color and shake it five to six times to distribute the 

toner evenly.

NOTE: 
• Ensure that the color of the new toner cartridge matches that on the handle before replacing it.
• Handle the toner cartridge carefully to avoid spilling of the toner.

2 Remove the tape from the toner cartridge.

3 Adjust the toner cartridge to the associated cartridge holder, and then insert it firmly by pressing 
near the center of the label until the toner cartridge clicks.

4 Close the toner access cover.
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5 Pack the removed toner cartridge in the box in which the installed toner cartridge was packed up.

6 Take care not to contact with the spilled toner and remove the sheets of paper spread under the 
removed toner cartridge.
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Ordering Supplies
This section includes:

• "Consumables" on page 249
• "When to Order Toner Cartridges" on page 250
• "Recycling Supplies" on page 251

The toner cartridges need to be ordered occasionally. Each toner cartridge includes installation 
instructions on the box.
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Consumables
IMPORTANT: 
• Use of consumables not recommended by Fuji Xerox can impair machine quality and performance. Use only 

consumables recommended by Fuji Xerox.

IMPORTANT: 
• The printable number of pages are applicable when A4 paper SEF ( ) is used and printing is done 

continuously at a density such that each toner covers 5% of the page. These values are estimates and vary 
depending on conditions such as the content being printed, paper size, paper type, the machine’s operating 
environment, initializing process done when you turn on or off the printer, and adjustments to maintain print 
quality.

NOTE: 
• The printable number of pages for the starter toner cartridges shipped with the printer are approximately 1000 

pages for black toner cartridge and 700 pages for yellow, magenta, and cyan toner cartridges.
• Each toner cartridge includes installation instructions on the box.

Product Name Product Code Printable number of pages
Toner Cartridge [Black] CT201591 Approx. 2000 pages

Toner Cartridge [Yellow] CT201594 Approx. 1400 pages

Toner Cartridge [Magenta] CT201593 Approx. 1400 pages

Toner Cartridge [Cyan] CT201592 Approx. 1400 pages
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When to Order Toner Cartridges
The LCD panel displays a warning when the toner cartridge nears its replacement time. Verify that you 
have replacements on hand. It is important to order a toner cartridge when the messages first appear 
to avoid interruptions to your printing. The LCD panel displays an error message when the toner 
cartridge must be replaced.
To order toner cartridges, contact the Fuji Xerox local representative office or an authorized dealer.

IMPORTANT: 
• This printer is designed to provide the most stable performance and print quality when used with the 

recommended toner cartridges. Not using toner cartridges recommended for this machine degrades the 
performance and printing quality of the printer. You could also incur charges if the machine breaks down. To 
receive customer support and achieve the optimum performance of the printer, be sure to use recommended 
toner cartridges.
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Recycling Supplies
• For environmental protection and efficient use of resources, Fuji Xerox reuses returned toner 

cartridges to make recycle parts, recycle materials or energy recovery.
• Proper disposal is required for toner cartridges no longer needed. Do not open toner cartridges 

containers. Return them to your local Fuji Xerox representative.
• To recover scarce resources, rechargeable batteries used in the returned machines are recycled 

as materials or reused for energy generation.
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Storing Consumables
Store consumables in their original packaging until you need to use them. Do not store consumables 
in:

• Temperatures greater than 40 °C (140 °F).
• An environment with extreme changes in humidity or temperature.
• Direct sunlight.
• Dusty places.
• A car for a long period of time.
• An environment where corrosive gases are present.
• An environment with salty air.
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Managing the Printer
This section includes:

• "Checking or Managing the Printer with CentreWare Internet Services" on page 254
• "Checking Printer Status with SimpleMonitor (Windows Only)" on page 255
• "Checking Printer Status Through E-mail" on page 256
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Checking or Managing the Printer with CentreWare 
Internet Services

When the printer is installed in a TCP/IP environment, you can check printer status and configure 
settings using a web browser on a network computer. You can also use CentreWare Internet Services 
to check the remaining volume of consumables and the paper loaded in this printer.

NOTE: 
• When using the printer as a local printer, you cannot use CentreWare Internet Services. For details about 

checking the status of a local printer, refer to "Checking Printer Status with SimpleMonitor (Windows Only)" on 
page 255.

Starting CentreWare Internet Services
Use the following procedure to start CentreWare Internet Services.

1 Launch your web browser.

2 Enter the IP address of the printer in the address bar.
The CentreWare Internet Services page appears.

• Using Online Help
For details regarding the items that can be set in each CentreWare Internet Services screen, click the 
Help button to display the online Help.
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Checking Printer Status with SimpleMonitor (Windows 
Only)

SimpleMonitor is a tool that is installed with your Fuji Xerox print driver. It automatically checks the 
printer status when you send a print job. SimpleMonitor can also check the status of the paper tray 
and remaining amount of toner cartridges.

Starting SimpleMonitor
Double-click the SimpleMonitor icon on the taskbar or right-click the icon and select Select Printer.
If the SimpleMonitor icon is not displayed on the taskbar, open SimpleMonitor from the start menu.
The following procedure uses Microsoft® Windows® XP as an example.

1 Click start → All Programs → Fuji Xerox → SimpleMonitor for Asia-Pacific → Activate 
SimpleMonitor.
The Select Printer window appears.

2 Click the name of the desired printer from the list.
The Status Monitor window appears.

For details about the functions of SimpleMonitor, refer to the online Help.
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Checking Printer Status Through E-mail
When connected in a network environment where sending and receiving of e-mail is possible, the 
printer can send an e-mail report to specified e-mail addresses containing the following information:

• The network settings and the printer status
• The error status which has occurred on the printer
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Setting the E-mail Environment
Activate CentreWare Internet Services. On the Properties tab, configure the following settings 
according to your e-mail environment. After configuring the settings on each screen, always click 
Apply and then turn off/on the printer to reboot. For details about each item, refer to the online Help 
for CentreWare Internet Services.

Item Item to be configured Description
General Setup > 
StatusMessenger

Recipient's E-mail 
Address

Set the e-mail address to which notices about 
changes in printer status or errors are sent.

Notification Items Set the contents of the notices to send in the e-mail.

Port Status StatusMessenger Select the Enabled check box.

Protocol Settings > 
E-mail

SMTP Server Settings
• Machine's E-mail 

Address
• SMTP Server 

Address
• SMTP Server Port 

Number

Send Authentication
• E-Mail Send 

Authentication
• Login Name
• Password
• Re-enter Password
• SMTP Server 

Connection Status

POP3 Server Settings
• POP3 Server 

Address
• POP3 Server Port 

Number
• Login Name
• Password
• Re-enter Password
• POP3 Server Check 

Interval
• APOP Settings
• POP3 Server 

Connection Status

Select appropriate settings for sending and 
receiving e-mail.

Permitted E-mail Address When setting the permission for checking 
information and changing the settings for an e-mail 
address, input the e-mail address that is permitted 
to receive the e-mail. If no address is input here, the 
printer receives e-mails from all users.

StatusMessenger 
Password

Set the password for access to the printer.
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Checking the Printer Status with E-mail
This section describes cautions when sending e-mail to the printer to check the printer status.

• You can specify any title for the e-mail when checking the printer status or changing the printer 
settings.

• Use the commands described in the next section to create the text of the e-mail.

• Commands That Can Be Used in E-mail Text
Use each command according to the following rules:

• Prefix all commands with “#”, and specify the #Password command at the top of the e-mail.
• Command lines without “#” are ignored.
• Write one command on each line and separate each command and parameter with a space or a 

tab.
When the same command is written two or more times in one e-mail, the second and subsequent 
commands are ignored.

• Example of Commands
• When the read only password is “ronly”, and to check the printer status:

#Password ronly

#Status

#NetworkInfo

Command Parameter Description
#Password Password Use this command at the top of the e-mail when a 

password is set. You can omit this command when the 
password is not set.

#NetworkInfo Set this when you want to check information on the 
network settings list.

#Status Set this when you want to check the printer status.
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Conserving Supplies
You can change a setting in your print driver to conserve paper.

Supply Setting Function
Print media Multiple-Up in the Layout 

tab of the print driver
The printer prints two or more pages on one side of a 
sheet. The available numbers that each print driver can 
print one sheet of paper are as follows:
• Microsoft Windows Print Driver: 2, 4, 8, 16, or 32 

pages
• Mac OS® X Print Driver: 2, 4, 6, 9 or 16 pages

Combined with the duplex setting, Multiple-Up allows 
you to print up to 64 pages on one sheet of paper. (32 
images on the front and 32 on the back)
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Checking Page Counts
The total number of printed pages can be checked at the operator panel. Four meters are available: 
Meter 1 (color prints), Meter 2 (monochrome prints), Meter 3(large size color prints), and Meter 
4(Meter 1 + Meter 2).
The Billing Meters counts the number of pages printed properly. Single side color print (including 
Multiple-Up) is counted as one job, and 2-sided print (including Multiple-Up) is counted as two. During 
2-sided printing, if an error occurs after one side is printed properly, it is counted as one.
When printing color data, which has been converted by using ICC profile on an application, with the 
Color setting, the data is printed by color even if it seems to be black and white data on the monitor. In 
that case, Meter 1 and Meter 4 are increased.
When doing 2-sided printing, a blank page may be inserted automatically depending on the settings of 
the application. In this case, the blank page is counted as one page. However, when doing 2-sided 
printing for odd number of pages, the blank page inserted to the rear side of the last odd page is not 
counted.

See also: 
• "Billing Meters" on page 166

Use the following procedure to check a meter:

1 Press the  (Menu) button.

2 Select Billing Meters, and then press the  button.

3 Check the values for each meter.
Maintenance 260



Moving the Printer
NOTE: 
• The front side of this printer is heavier than the rear. Take note of this difference in weight when moving the 

printer.

1 Turn off the printer.

2 Disconnect the power cord and the interface cable.

3 Remove any paper in the center output tray if there is. Close the output tray extension if it is 
opened.

4 Remove any paper in the priority sheet inserter (PSI) or multipurpose feeder (MPF). Keep the 
paper wrapped and away from humidity and dirt.
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5 Push the PSI in.

6 Slide the slide bar backward until it stops.

7 Close the front cover.
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8 Lift the printer and move it gently.

NOTE: 
• If the printer is to be moved over a long distance, the toner cartridges should be removed to prevent toner 

from spilling and the printer should be packed inside a box.

9 Adjust the color registration before using your printer.

See also: 
• "Adjusting Color Registration" on page 216
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Contacting Fuji Xerox
This chapter includes:

• "Technical Support" on page 266
• "Online Services" on page 267
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Technical Support
Fuji Xerox recommends the Customer first utilize support materials shipped with the product, product 
diagnostics, information contained on the Web, and email support. If unsuccessful, to obtain service 
under product warranty the Customer must notify Fuji Xerox Telephone Support or its authorized 
service representative of the defect before the expiration of the warranty period. Customer will provide 
appropriate assistance to Telephone Support personnel to resolve issues, such as restoration of the 
operating system, software program and drivers to their default configuration and settings, verification 
of functionality of Fuji Xerox supplied products, replacement of customer replaceable units, clearing 
paper misfeeds and cleaning the unit and other prescribed routine and preventative maintenance.
If the Customer’s product contains features that enable Fuji Xerox or its authorized service 
representative to diagnose and repair problems with the product remotely, Fuji Xerox may request that 
the Customer allow such remote access to the product.
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Online Services
You can find detail Product and Consumable warranty information and activate your warranty by 
registering your details on our website at http://www.fujixerox.com/support/docuprint/
Fuji Xerox Online Support Assistant provides instructions and troubleshooting guides to resolve your 
printer problems. It is an easy-to-use, searchable online help. To find out more, please visit our online 
support at http://www.fujixerox.com/support/docuprint/
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